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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crores people, one out of every

four Indians, to help them secure jobs as part of the National Skills Development Policy. Industrial Training

Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.  Keeping

this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus has been

recently updated with the help of  Media Development Committee members of various stakeholders viz.

Industries, Entrepreneurs, Academicians and representatives from ITIs.

The National Instructional Media Institute (NIMI), Chennai, has now come up with instructional

material to suit the revised curriculum for Draughtsman Mechanical  2nd Year Trade Practical in

CG & M Sector under Yearly Pattern. The NSQF Level - 4 (Revised 2022) Trade Practical will help the

trainees to get an international equivalency standard where their skill proficiency and competency will be

duly recognized across the globe and this will also increase the  scope of recognition of prior learning.

NSQF Level - 4 (Revised 2022) trainees will also get the opportunities to promote life long learning and skill

development. I have no doubt that with NSQF Level - 4 (Revised 2022)  the trainers and trainees of ITIs, and

all stakeholders will derive maximum benefits from these Instructional Media Packages IMPs and that

NIMI's effort will go a long way in improving the quality of Vocational training in the country.

The Director General, Executive Director & Staff of NIMI and members of Media Development Committee

deserve appreciation for their contribution in bringing out this publication.

Jai Hind

           ATUL KUMAR TIWARI, I.A.S

Secretary

Ministry of Skill Development & Entrepreneurship,

Government of India.

         December 2023

         New Delhi - 110 001
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(iv)

PREFACE

The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by then Directorate

General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Ministry

of Skill Development and Entrepreneurship) Government of India, with technical assistance from the Govt.

of the Federal Republic of Germany. The prime objective of this institute is to develop and provide instructional

materials for various trades as per the prescribed syllabus under the Craftsman and Apprenticeship Training

Schemes.

The instructional materials are created keeping in mind, the main objective of Vocational Training under

NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are

generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical

book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and

other support materials.

The trade practical book consists of series of exercises to be completed by the trainees in the workshop.

These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade

theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and

assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.

The wall charts and transparencies are unique, as they not only help the instructor to effectively present a

topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to

plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.

In order to perform the skills in a productive manner instructional videos are embedded in QR code of the

exercise in this instructional material so as to integrate the skill learning with the procedural practical steps

given in the exercise. The instructional videos will improve the quality of standard on practical training and

will motivate the trainees to focus and perform the skill seamlessly.

IMPs also deals with the complex skills required to be developed for effective team work. Necessary care

has also been taken to include important skill areas of allied trades as prescribed in the syllabus.

The availability of a complete Instructional Media Package in an institute helps both the trainer and

management to impart effective training.

The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media

Development Committees specially drawn from Public and Private sector industries, various training institutes

under the Directorate General of Training (DGT), Government and Private ITIs.

NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training

of various State Governments, Training Departments of Industries both in the Public and Private sectors,

Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for

whose active support NIMI would not have been able to bring out this materials.

Chennai - 600 032      EXECUTIVE DIRECTOR

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



(v)

ACKNOWLEDGEMENT

National Instructional Media Institute (NIMI) sincerely acknowledges with thanks for the co-operation and

contribution extended by the following Media Developers and their sponsoring organisations to bring out this

Instructional Material (Trade Practical)  for the trade of  Draughtsman Mechanical  2nd Year  NSQF Level - 4

(Revised 2022) under Capital Goods & Manufacturing Sector for ITIs.

MEDIA DEVELOPMENT COMMITTEE MEMBERS

Shri. V. Dhivakar - ATO, Govt ITI ,

Guindy, Tamil nadu.

Shri. C.S. Kumar - ATO, Govt ITI,

North Chennai.

Shri. T. Chithra - ATO, Govt ITI,

Cuddalore.

Shri. C.S. Nagarathinam - ATO, Govt ITI,

Ulundurpet.

Shri. M.A. Mangaleshwaran - JTO, Govt ITI,

Ramanadhapuram.

Shri. V. Dhanasekaran - ADT,(Retd) Mdc member,

Nimi Chennai.

Shri. V. Janarthanan - Asst prof.(Retd) Mdc member,

Nimi Chennai.

NIMI CO-ORDINATORS

Shri.Nirmalya Nath - Deputy Director of Training,

NIMI- Chennai - 32.

Shri. V. Gopalakrishnan - Manager,

NMI, Chennai - 32

NIMI records its appreciation of the Data Entry, CAD, DTP Operators  for their excellent and devoted services in

the process of development of this Instructional Material.

NIMI also acknowledges with thanks, the invaluable efforts rendered by all other staff who have contributed for the

development of this Instructional Material.

NIMI is grateful to all others who have directly or indirectly helped in developing this IMP.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



(vi)

INTRODUCTION

TRADE PRACTICAL

The trade practical manual is intended to be used in practical workshop. It consists of a series of practical
exercises to be completed by the trainees during the course. These exercises are designed to ensure that all
the skills in compliance with NSQF Level - 4 (Revised 2022) syllabus are covered.

The manual is divided into Nine modules

The skill training in the shop floor is planned through a series of practical exercises centered around some
practical project. However, there are few instances where the individual exercise does not form a part of project.

While developing the practical manual, a sincere effort was made to prepare each exercise which will be easy to
understand and carry out even by below average trainee. However the development team accept that there is a
scope for further improvement. NIMI looks forward to the suggestions from the experienced training faculty for
improving the manual.

TRADE THEORY

The manual of trade theory consists of theoretical information for the  Course of the  Draughtsman Mechanical

2nd Year  NSQF Level - 4 (Revised 2022) in CG & M. The contents are sequenced according to the practical
exercise contained in NSQF Level - 4  (Revised 2022) syllabus on Trade Theory attempt has been made to relate
the theoretical aspects with the skill covered in each exercise to the extent possible. This correlation is
maintained to help the trainees to develop the perceptional capabilities for performing the skills.

The trade theory has to be taught and learnt along with the corresponding exercise contained in the manual
on trade practical. The indications about the corresponding practical exercises are given in every sheet of
this manual.

It will be preferable to teach/learn trade theory connected to each exercise at least one class before performing
the related skills in the shop floor. The trade theory is to be treated as an integrated part of each exercise.

The material is not for the purpose of self-learning and should be considered as supplementary to class room
instruction.

Module 1 Computer aided drafting practice

Module 2 Types of Pulleys

Module 3 Pipe joints

Module 4 Gears and cams

Module 5 IC Engine parts and Assembly

Module 6 3D Solid objects

Module 7 Detailed and assemble drawing

Module 8 Solid works

Module 9 Production drawing
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(vii)

CONTENTS

Module 1 : Computer aided drafting practice

2.1.94 Drawing 2D object using line, polyline, regular polygon, Circle
rectangle, arc ellipse commands 1

2.1.95 & 96 Modify 2D objects using break, erase, trim, offset, fillet, chamber,
move, copy, array, rotate, Hatch command 8

2.1.97 CAD: Create templates, insert  drawing-create objects in different
layers and modify layer properties 12

2.1.98 Dimensioning by Auto CAD 14

2.1.99 CAD: Construct or thographic sectional view of a steel bracket
with dimension 17

2.1.100 Construct isometric view of machine blocks 18

2.1.101 Create view ports in layout Space 19

Module 2 : Types of Pulleys

2.2.102 Construct pulleys using CAD 23

2.2.103 Construct pulley with different types of arms                                          2 24

2.2.104 Draw rope pulley and vee belt pulley using CAD 25

Module 3 : Pipe joints

2.3.105 Draw pipe fittings 27

2.3.106 Draw conventional symbols of different types of valves and joints
used on pipe line diagram                                                                    3 28

2.3.107 Draw the piping layout system 31

2.3.108 Draw the sectional view of different types of pipe joints 32

Module 4 : Gears and cams

2.4.109 Gears 35

2.4.110 Construct involute tooth profile of a gear                                                 4 40

2.4.111 & 112 Draw a symmetrical cam profile 43

Module 5 : IC Engine parts and Assembly

2.5.113 Construct detailed and Assembly drawing 50

2.5.114 Construct detailed drawing of an Air valve 56

2.5.115 Fuel injector of diesel Engine 58

Module 6 : 3D Solid objects

2.6.116 3D Modelling                                                                                        6 60

Module 7 : Detailed and assemble drawing

2.7.117 Construct detailed drawing of a lever safety valve 69

2.7.118 Construct detailed drawing of a gate valve 72

2.7.119 Construct detailed drawing of a steam stop valve and blow of cock            7 74

2.7.120 Hydraulics & pneumatics conventional signs and symbols 76

2.7.121 Draw sectional view of hydraulic jack and pneumatic valve actuator 79

2.7.122 Draw sectional view of a volute casing centrifugal pump 80

     Exercise No. Title of the Exercise                                      Learning   Page No.
                                                                     Outcome

111

11

11

11

115

11
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(viii)

     Exercise No. Title of the Exercise                                      Learning   Page No.
                                                                     Outcome

2.7.123 Draw the detailed drawing of a lathe tool post 81

2.7.124 Construct detailed drawing of tail stock 83

2.7.125 Construct detailed drawing of a milling fixture 86

2.7.126 Construct detailed assembly drawing of shaper tool head slide 88

2.7.127 Draw a simple drilling Jig for drilling holes 89

2.7.128 & 129 Draw the detailed drawing of a Press tools - dies - punches 92

2.7.130 Develop isometric drawing for injection mould with side cavities 98

2.7.131 Construct a detailed drawing of a simple carburettor 99

2.7.132 Construct detailed drawing of a Pressure vessel 101

2.7.133 Prepare detailed drawing of a ‘c’ clamp 103

2.7.134 Draw a simple machine shop layout of small industry 104

Module 8 : Solid works

2.8.135 Draw 3D solid figure by sketching features and applied feature 106

2.8.136 Sketch an angle plate and a block 109

2.8.137 Create a Sketch of a new part 113

2.8.138 Create 3D Solid and Edit using copy Loop, File time, C hampering,
Editing, Create rib, mirror, Hole wizard, create part confirmation 116

2.8.139 Create New Assembly Part                                                                     8 120

2.8.140 Create a 3D Model 124

2.8.141 Prepare drawing & detailing 126

2.8.142 Create a 3D transition figure: Create 3D model by annotating holes
and threads, create centre lines, symbols and leaders, create
simulation, plot the model 128

2.8.143 Convert or save as solid works file into drawing format 129

Module 9 : Production drawing

2.9.144 Construct detailed and Assembly drawing 130

2.9.145 Create production drawing of a screw jack                                                9 133

2.9.146 Create the check list for self assessment revision table 135

11

11

11
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(ix)

LEARNING / ASSESSABLE OUTCOME

On completion of this book you shall be able to

S.No Learning Outcome Ref. Ex.No.

1 Construct projection views of geometrical figures with dimension and
annotation on CAD in model space and viewport in layout space.
(CSC/NO402) 2.1.94 - 2.1.101

2 Draw in CAD detail and assembly drawing of machine parts viz., Pulleys,
Pipe fittings, Gears and Cams applying range of cognitive and practical
skills. (CSC/NO402) 2.2.102 - 2.2.112

3 Construct drawing of engine parts with detailed and assembly in template
layout applying quality concept in CAD. (CSC/NO402) 2.3.113 - 2.3.115

4 Create 3D solid by switching to 3D modeling workspace in CAD, generate
views, Print Preview and Plotting. (CSC/NO402) 2.4.116

5 Construct detailed and assembled drawing applying conventional sign &
symbolsusing CAD. (CSC/NO402) 2.5.117 - 2.4.132

6 Prepare drawing of machinepart by measuring with gauges and measuring
instruments. (CSC/NO402) 2.6.133

7 Draw a machine shop layout considering process path and ergonomics
(human factor). (CSC/NO402) 2.7.134

8 Create and plot assembly and detail views of machine part with
Dimensions, Annotations, Title Block and Bill of materials in
SolidWorks/AutoCAD Inventor/ 3D Modeling. (CSC/NO402) 2.8.135 - 2.8.143

9 Create production drawing of machine part. (CSC/NO402) 2.9.144 - 2.9.146
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(x)

Professional
Skill 110 Hrs;

Professional
Knowledge 34
Hrs

Construct projection
views of geometrical
figures with dimension
and annotation on CAD
in model space and
viewport in layout
space. (Mapped NOS:
CSC/NO402)

94. CAD: draw 2D object using line,
polyline, ray, polygon, circle,
rectangle, arc, ellipse commands.
(20 hrs)

95. CAD: modify 2D objects using
Break, Erase, Trim, Offset, Fillet,
Chamfer Commands. (10 hrs)

96. CAD: manage 2D objects using
Move, Copy, Array, Insert Block,
Make Block, Scale, Rotate, Hatch
Commands. (12 hrs)

97. CAD: Create templates, Insert
drawings. Create objects in different
Layers and Modify Layer properties.
(20 hrs)

98. CAD: Provide dimension on object.
Create dimension by customizing
dimension styles (lines, arrows,
text, unit and alignment) Put
dimension with scale factor. (20 hrs)

99. CAD: Construct orthographic
sectional view of a steel bracket with
dimension using shortcut keyboard
command.(10 hrs)

100. Construct isometric view of
machine blocks. (10 hrs)

101. Create viewports in layout space
and place views for model space in
different scale. (08 hrs)

102. Construct Pulleys: solid, stepped
and built up pulleys. (10 hrs)

103. Construct pulley with different
types of arms. (10 hrs)

104. Draw rope pulley and v-belt pulley
using CAD. (10 hrs)

105. Draw pipe fittings: tee, elbow (90°
& 45°), flange, union and valve. (10
hrs)

106. Draw conventional symbols of
different types of valves and joints
used in pipe line diagram. (10 hrs)

107. Draw a piping layout systems from
a sump to an overhead tank through
a pump with possible fittings and
valves. (10 hrs)

Drawing of Line, polyline, ray,
polygon, circle, rectangle, arc,
ellipse using different options.
(07 hrs.)

Trim, Offset, Fillet, Chamfer, Arc
and Circle under modify
commands.

Move, Copy, Array, Insert Block,
Make Block, Scale, Rotate, Hatch
Commands. (07 hrs.)

SYLLABUS

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)

Creating templates, Inserting
drawings, Layers, Modify Layers.
(07 hrs.)

Format dimension style, creating
new dimension style, Modifying
styles in dimensioning. Writing text
on dimension line and on leader.
Edit text dimension. (07 hrs.)

Knowledge of shortcut keyboard
command. Customization of
keyboard command.

Customization of drafting

settings, changing orthographic
snap to isometric snap.

Procedure to create viewport in
layout space in zooming scale.
(06 hrs.)

Belt-drive. Materials of belts, slip
and creep, Velocity of belt. Arc of
contact. Simple exercise in
calculation of belt speeds, nos. of
belts needed in V-belt drive,
velocity, pulley ratio etc. Standard
pulleys width of pulley face, velocity
ratio chain drive. (07 hrs.)

Knowledge of different pipe
materials and specifications of
Steel, W.I. & PVC pipes.

Brief description of different types
of pipe joints.

Pipe threads.

Pipe fittings (threaded, welded and
pressed).

Specifications of pipe fittings.

Profess ional
Skill 140Hrs;

Profess ional
Knowledge 50
Hrs

Draw in CAD detail and
assembly Drawing of
machine parts viz.,
Pulleys, Pipe fittings,
Gears and Cams
applying range of
cognitive and practical
skills. (Mapped NOS:
CSC/NO402)
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(xi)

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)

Different types of valves. (14 hrs.)

Gear drive- Different types of gears.
Cast gears and machined gears.
Knowledge of profile of gears etc.
(14 hrs.)

108. Draw sectional views of different
types of pipe joints using CAD.
(10 hrs)

109. Draw:

i) spur gear, (08 hrs)

ii) helical gear, (08 hrs)

iii) bevel gear, (08 hrs)

iv) worm and worm wheel. (08 hrs)

110. Construct involute tooth profile of
a gear (using CAD). (08 hrs)

111. Draw a symmetrical cam profile.
(15 hrs)

112. Draw different types of follower
(using CAD).(15 hrs)

113. Construct detailed and assembly
drawing (using CAD) of

i) Eccentrics (10 hrs),

ii) Stuffing box (12 hrs)

iii) Piston assembly of a petrol engine
(20 hrs),

iv) IC engine connecting rod. (20 hrs)

114. Construct detailed drawing of an
air valve. (28 hrs)

115. Construct detailed drawing of a
fuel injector of a diesel engine. (20
hrs) (using CAD)

116. 3D Modeling:

i) Create 3D solid objects

using command from 3D primitive (viz.
box, sphere, cylinder and poly-
solids) , from solid (extrude,
revolve, sweep and loft), from
Boolean (union, subtract and
intersect) (20 hrs)

ii) Create 3D drawing using User co-
ordinate systems. (13 hrs)

iii) Annotate and dimension of the 3D
model. (05 hrs)

iv) Generate views from model space
to layout space. (05 hrs)

v) Generate Print preview and Plotting.
(03 hrs)

Use of Cams in industry.

Types of cam, kinds of motion in
cam, displacement diagrams.
Terms used in cam. Types of
follower. (15 hrs.)

Knowledge of engine mechanism.

Transmission of motion from
reciprocating to circular through
eccentric, crank and connecting
rod. (21 hrs.)

Professional
Skill 110Hrs;

Professional
Knowledge 35
Hrs

Construct drawing of
engine parts with
detailed and assembly in
template layout applying
quality concept in CAD.
(Mapped NOS: CSC/
NO402)

Knowledge of fuel injection system
in petrol and diesel engine. (14 hrs.)

P ro fess iona l
Skill 46Hrs;

P ro fess iona l
K n o w l e d g e
12Hrs

Create 3D solid by
switching to 3D
modeling workspace in
CAD, generate views,
Print Preview and
Plotting. (Mapped NOS:
CSC/NO402)

Introduction to 3D modeling,

3D primitives (viz. box, sphere,
cylinder, mesh and poly-solids),
solid figure by extrude, revolve,
sweep and loft command, solid
editing: fillet, offset, taper, shell and
slice command.

Setting of User co-ordinate
Systems, Rotating, Print preview
and Plotting. (12 hrs)
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(xii)

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)

Construct detailed and
assembled drawing
applying conventional
sign & symbols using
CAD. (Mapped NOS:
CSC/NO402)

Pro fess iona l
Skill 260 Hrs;

Pro fess iona l
Knowledge 90
Hrs

117. Construct detailed drawing of a
lever safety valve.(20 hrs)

118. Construct detailed drawing of a
gate valve.(20 hrs)(using CAD)

119. Construct detailed drawing of a
steam stop valve and blow off cock.
(20 hrs) (using CAD)

120.Create library folder
containingblocks of hydraulic and
pneumatic conventional signs and
symbols. (10 hrs)

121. Draw a sectional view of a
hydraulic jack and a pneumatic valve
actuator. (10 hrs)(using CAD)

122. Draw detail and full sectional view
of a volute casing centrifugal
pump(using CAD). (20 hrs)

123. Draw assembly and detailed
drawing of tool post of a lathe. (using
CAD) (20 hrs)

124. Construct detailed &assembly
drawing of tail stock and revolving
centre. (using CAD) (20 hrs)

125. Construct detailed drawing of a
milling fixture. (using CAD) (20 hrs)

126. Construct detailed & assembly
drawing of shaper tool head slide.
(using CAD) (20 hrs)

127. Draw a simple drilling jig for drilling
holes in a given component. (using
CAD) (20 hrs)

128. Draw a Press Tool giving
nomenclature of each part. (08 hrs)

129. Draw dies & punches for the
production of simple work pieces.
(using CAD) (06 hrs)

130. Develop isometric drawing for
manufacturing 2 cavity injection
moulds with side cavities. (using
CAD)(06 hrs)

131. Construct detailed drawing of a
simple carburetor.(using CAD) (20
hrs)

Working principle of valves and their
description. (13 hrs.)

Knowledge of simple stationary fire
tube boiler, boiler mountings.
Function and purpose of blow off
cock. (07 hrs.)

Brief description of a typical
hydraulic system, components,
working principle and function of
hydraulic jack. Different types of
hydraulic actuator. Symbol and
working of hydraulic DC valve, non-
return valve and throttle valve.

Knowledge of typical pneumatic
system, FRL or air service unit and
pneumatic actuator. (07 hrs.)

Different types of pump
systems.Characteristics of a pump
system: pressure, friction and
flow.Energy and head in pump
systems. (07 hrs.)

Different clamping devices on lathe.
(07 hrs.)

Description of different job holding
devices in lathe operation. (07 hrs.)

Different clamping devices on milling
operation. (07 hrs.)

Different clamping devices on
shaping operation. (07 hrs.)

Knowledge of accuracy and
i n t e r c h a n g e a b i l i t y i n t h e
manufacturing of products. (07 hrs.)

Knowledge of various parts of press
tools and their function.

Knowledge of different moulding
processes.

Introduction to Die casting, gating
system design, force calculation,
defects and remedies and
estimation. (07 hrs.)

Description of different parts of petrol
engine. (07 hrs.)
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(xiii)

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)

Knowledge of design, manufacture,
and operation of pressure vessels.
(07 hrs.)

Proper measurement practice in
workshop.

Principles of good measurement
result: right measurement, right
tools, right sketching, review and
right procedures.(08 hrs.)

Lay out of Machine foundations.

Brief treatment of the principle

Involved and the precautions to be
observed. Lay out of machine
Foundation.

Consideration of ergonomics
(human factor) for shop layout.
(06 hrs.)

Introduction to SolidWorks/
AutoCAD Inventor/ 3D Modeling

User interface - Menu Bar –
Command manager – Feature
manager – Design Tree – settings
on the Default options – suggested
settings – key board short cuts.

Create the best profile – create a
sketch – create a new part. (07
hrs.)

Extrude bosses and cuts, add
fillets, and chamfer changing
dimensions.

Revolved features using axes,
circular patterning changes and
Rebuild problems. (07 hrs.)

132. Construct detailed and assembly
drawing of a simple pressure
vessel. (using CAD) (20 hrs)

133. Prepare detailed drawing of a C-
clamp and a machine vice by
taking measurement using gauges
and measuring instrument. (using
CAD) (20 hrs)

134. Draw a machine shop layout of
small production industry showing
material inflow to finished product
stock. (using CAD) (20 hrs)

SolidWorks/AutoCAD Inventor/ 3D
Modeling:

135. Draw 3D solid figures by
Sketching features & applied
features. (08 hrs)

136. Sketch an angle plate and a block
– Create/ Modify constraints. (06
hrs)

137. Create a sketch of a new part.
(08 hrs)

138. Create 3D solid and edit using:

i) Copy & Paste, (03 hrs)

ii) Filleting, (03 hrs)

iii) Chamfering, (03 hrs)

iv) Editing a feature definition. (03 hrs)

v) Create ribs, mirror pattern, the Hole
wizard, (03 hrs)

vi) Create part configurations, Part
design tables, (03 hrs)

vii) Inset Design Table, Inset new
design table. (03 hrs)

139. Create New assembly part:

i) Create a new assembly (06 hrs)

ii) Insert components into an assembly,
(03 hrs)

iii) Add mates (degree of freedom). (03
hrs)

iv) Perform components configuration
in an assembly, (03 hrs)

Professional
Skill 20Hrs;

Professional
K n o w l e d g e
08Hrs

Professional
Skill 20Hrs;

Professional
K n o w l e d g e
06Hrs

Professional
Skill 110 Hrs;

Professional
Knowledge 35
Hrs

Prepare drawing of
machineparts by
measuring with gauges
and measuring
instruments. (Mapped
NOS: CSC/NO402)

Draw a machine shop
layout considering
process path and
ergonomics (human
factor). (Mapped NOS:
CSC/NO402)

Create and plot
assembly and detail
views of machine part
with Dimensions,
Annotations, Title Block
and Bill of materials in
SolidWorks/AutoCAD
Inventor/ 3D Modeling.
(Mapped NOS: CSC/
NO402)

Bottom up assembly modeling

Components configuration in an
assembly, Insert subassemblies,
Interference detection. (07 hrs.)
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(xiv)

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)

v) Insert subassemblies, (03 hrs)

vi) Perform Interference detection.
(03 hrs)

Drawings & Detailing, create
drawing sheets, Add drawing
items, Named views, std. 3 views,
auxiliary views, section views,
detail views.

Drawings & Detailing, create
drawing sheets, Add drawing
items, Named views, standard 3
views, auxiliary views, section
views, detail views. (07 hrs.)

140. Create a 3D model putting:

i) Driving dimensions, (02 hrs)

ii) Bill of materials, (02 hrs)

iii) Driven (Reference) Dimensions, (02
hrs)

iv) Annotations, (02 hrs)

v) Alternate position view. (02 hrs)

141. Prepare drawings & detailing:

i) Create drawing sheets, (02 hrs)

ii) Add drawing items, (02 hrs)

iii) Named views, standard 3 views,
auxiliary views, section views, detail
views. (02 hrs)

iv) Reattach and replace dimensions,
(02 hrs)

v) Edit sketch, (02 hrs)

vi) Edit sketch plane, (02 hrs)

vii) Edit definition. (02 hrs)

142. Create a 3D transition figure

• using loft feature. (03 hrs)

• using sweep feature. (03 hrs)

• using library features.(03 hrs)

i) Create 3D model by annotating Holes
and Threads, (03 hrs)

ii) Create Centerlines, symbols and
leaders, (03 hrs)

iii) Create Simulation. (03 hrs)

iv) Plot the model. (01 hr)

143. Convert or save as Solid Works
and Inventor file into .dwg format.
(03 hrs)

Difference between sweep and loft.

Exploded views – Configuration
manager, Animation controller.

Annotating Holes and Threads,
Creating Centerlines, symbols and
leaders, Simulation. Introduction to
plot & Different ways of plotting.
(07 hrs.)

Professional
Skill 24 Hrs;

Professional
Knowledge 06
Hrs

Create production
drawing of machine part.
(Mapped NOS: CSC/
NO402)

144. Create production drawing of a
simple Drill jig – Part model –
assembly-detailing (using CAD).
(12 hrs)

145. Create production drawing of a
Screw jack – Part model –
assembly-detailing. (10 hrs) (using
CAD)

146. Create a check list by self-
assessment and provide Revision
mark by noting in the Revision
table. (02 hrs)

Knowledgeof production drawing,
name plate and bill of materials, etc.

Study of production drawing.

Procedure of preparing Revision
Drawing: putting revision mark,
writing remarks in the table as per
check list. (06 hrs.)
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Capital Goods & Manufacturing  Exercise 2.1.94 
Draughtsman Mechanical - Computer aided drafting practice  

Drawing 2D object using line, polyline, regular polygon, Circle rectangle, arc 
ellipse commands
Objectives: At the end of this exercise you shall be able to
•	 draw	different	objects	using	Auto	CAD	commands	like,	line,	poly	line,	rectangle,	arc,	circle,	Ellipse	polygons.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

1 Draw tool bar:
The Draw commands can be used to create new 
objects such as lines and circles. Most AutoCAD 
drawings are composed purely and simply from these 
basic components. A good understanding of the Draw 
commands is fundamental to the efficient use of Auto 
CAD.(Fig 1)

2 Drawing Entity-LINE:
Lines can be drawn by anyone of the following three 
methods using LINE command.

a	 Using	Absolute	Co-ordinates:
Example:
Draw a line from point (5, 5) to point (10, 10).

Command: LINE

From point: 5, 5 (Select the point by mouse or enter the 
Co-ordinates by keyboard)

To point: 10, 10

To point: (Press ENTER) (Fig 2) 

b Using relative Co-ordinates:
Example:
Draw a line from point (2, 2) to point 5 units in X-axis 
and 8 units first co-ordinate.

Command: LINE

From point: 2,2

To point: @5, 8 

To point: (press ENTER) (Fig 3)

c Using Polar Co-ordinates:
Example:
Draw a line from point (1, 2) to a length of 6 units at 90 
degree.
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2 CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.94

Command: LINE

From point: 1,2

To point:6@<90

To point:( Press ENTER) (Fig 4)

3 Drawing Entity -PLINE:
A polyline is a connected sequence of line and arc 
segments. The command is PLINE.

Example:
Draw a thick line of width 2 units from point to point 
using PLINE command. (Fig 5)

4	 Drawing	Entity	-	RECTANGLE:
A rectangle is a polyline based on two opposite corner 
points called diagonal points. (A polyline is a connected 
sequence of line/ arc segments)

Example:
Draw a rectangle defined by diagonal points (10, 10) 
and (30, 20).

Command: RECTANGLE

First corner: 10, 10

Second Corner: 30, 20 (Fig 6)

5 Drawing Entity - CIRCLE
Circle can be drawn by any one of following five methods 
using CIRCLE command

a Using Centre and Radius:
Example:
Draw a circle with centre (6, 6) and radius 5 units.

Command: CIRCLE

3P/2P/TTR/ <Centre point>: 6,6

Diameter/<Radius>:5 (Fig 7)

b Using Centre and Diameter:
Example:
Draw a circle with centre (6, 17) and diameter 10 units.

Command: CIRCLE

3P/2P/TTR <Centre point>: 6, 17

Diameter/<Radius>: D

Diameter: 10 (Fig 8)

c Using Three given Points: (3P)
Example:
Draw a circle using the given 3points: (5,30), (4,26), 
(10,25). By entering 3 given points to be on the 
circumference of the circle:

Command: CIRCLE

3p/2P/TTR/ <Centre point: 3P

First point: 5, 30

Second point: 4,26

Third point: 10.25 (Fig 9)

d Using Two given Points: (2 P)
Example:
Draw a circle using the given 2 points: (7, 35), (7,47). 

By entering 2 end points of the circle diameter:

Command: CIRCLE
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3

3P/2P/TTR/<Centre point>:2P 

First point on diameter: 7, 35

Second point on diameter: 7, 47 (Fig 10)

e Using Tangent, Tangent and Radius:(TTR)
We can draw a circle by specifying two lines or two 
circles or a combination of line and circle, and also 
radius of circle. These two lines or two circles act as 
tangents to the circle.

6 Drawing Entity - ELLIPSE
Ellipse can be drawn by any one of following four 
methods using ELLIPSE command.

a Using First axis end points and other axis 
distance:

Example:
Draw an ellipse using major axis 

endpoints (10, 20), (60, 20) and minor

axis end point (35, 35). 

Command: ELLIPSE 

<Axis endpointl >/Center: 10, 20 

Axis endpoint2: 60, 20 

<Other axis distance> /Rotation: 35, 35 (Fig 11)

b Using Centre of ellipse axis, End point and other 
axis distance:

Example:
Draw an ellipse with centre (100, 20), major axis 
endpoint (125, 20) and minor axis end point (100.35).

Command: ELLIPSE

<Axis endpoint] >/ Centre: C 

Centre of Ellipse: 100, 20 

Axis endpoint2: 125.20 

<Other axis distance> /Rotation: 100, 35 (Fig 12)

c) Using Centre, End point and Rotation angle of 
circle around the axis:

Example:
Draw an ellipse with centre (35, 48), major axis endpoint 
(60, 48) and 65 degree rotation around the major axis.

Command: ELLIPSE

<Axis endpoint!>/Centre: C

Centre of Ellipse: 35, 48

Axis endpoint2: (60, 48)

<Other axis distance> /Rotation: R

Rotation around major axis: 65 (Fig 13)

7	 Drawing	Entity	-	ARC
Arcs are partial circles and can be drawn in eight 
different methods using ARC command.

a Using Three given Points:
Example:
Draw an arc using the given three points: (75, 50), (55, 
90), (105,110).

Command: ARC 

Center /<Start point>:75, 50 

Center/End/<Second point>: 55, 90 

Endpoint: 105,110 (Fig 14)

b Using Start point, Centre and Endpoint: (S, C, E)
Example:
Draw an arc using start point (240, 20), 

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.94
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centre point (250, 60) and endpoint (250, 100).

Command: ARC

Center/<Start point> :240,20

Center/End/<Second point>: C

Center point: 250, 60

Angle/Length of chord! <Endpoint>:250,100 (Fig 15)

c	 Using	 Start	 point,	 Centre	 and	 Included	 Angle:	 
(S,	C,	A)

Example:
Draw an arc using Start point (100,190),

centre point (40,190) and included angle 90 degrees.

Command: ARC

Center/<Start point>: 100, 190

Center/End/ <Second point>: C

Center: 40, 190 (Fig 16)

NOTE: Positive “included angle” draws are 
in	 clockwise	 and	 negative	 in	 anti	 clockwise	
direction.

d Using Start point, Centre and Length of chord : 
(S, C, L)

Example:
Draw an arc using start point (140.10), 

centre point (100, 10) and chord length 45 units.

Command: ARC

Center/<Start point>: 140, 10

Center/End/< Second point>: C

Center: 100, 10

Angle/Length of chord/ <Endpoint>: L

Length of chord: 45 (Fig 17)

e Using Start point, End point and Radius : 
( S, E, R)

Example:
Draw an are using start point (230, 80), endpoint (190, 
80) and radius 22 units.
Command: ARC
Center/<Start point>:230, 80
Center/End/<Second point E
Endpoint: 190, 80
Angle/Direction/Radius/ <Centre point>: R
Radius: 22 (Fig 18)

f	 Using	Start	point,	End	point	and	Included	Angle: 
(	S,	E,	A)

Example:
Draw an arc using start point (300, 60), end point 
(340,120) and included angle 90 degrees.
Command: ARC
Center/<Start point 300, 60
Center/End/ <Second point>: E
End point: 340, 120
Angle/Direction/Radius/ <Centre point>: A
Included Angle: 90 (Fig 19)

g Using Start point, End point and Starting 
Direction: (S, E, D)

Example:
Draw an arc with start point (40, 170), endpoint (70,230) 
and direction from start point 120 degrees.
Command: ARC
Center/<Start point>:40.170
Center/End/ <Second point>: E

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.94
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End point: 70, 230

Angle/Direction/Radius/ <Center point>:D

Direction from Start point: 120 (Fig 20)

h	 Using	Line/Arc	Continuation:
Example: Draw an arc with end point (200, 150) and 
tangential to the existing line. 

Take Existing line from point (150, 200) to point 
(200,200).

Command: ARC

Center/< Start point>: (Press ENTER) 

End point: 200, 150 (Fig 21)

NOTE: This command is also used to draw a 
continuous are after an arc is drawn.

8 Drawing Entity -POLYGON
The Polygon command draws regular 2D polygons 
with 3 to 1024 sides. Any polygon can be drawn by the 
following three methods using POLYGON command.
a Using Radius of given Circle in which polygon is 

inscribed:
Example:
Draw a polygon of eight sides with centre (50, 50) 
inscribed in a circle of radius 40 units.
Command: POLYGON
Number of sides: 8 (Fig 22) 

b Using Radius of given Circle on which polygon 
is circumscribed:

Example:
Draw an octagon with centre (140, 50) circumscribed on 
a circle of radius 40 units.

Command: POLYGON

Number of sides: 8

Edge/Center of polygon 140, 50 

Inscribed in circle/Circumscribed about circle (I/C): C

Radius of circle: 40 (Fig 23)

c Using Edge Method:
Example:
Draw a polygon of ten sides using “edge method.” The 
first end point of the edge is (90,100) and second end 
point of the edge is (120,100).

Command: POLYGON

Number of sides: 10

Edge/ <Center of polygon>: E

First end point of edge: 90, 100

Second end point of edge: 120, 100 (Fig 24)

9	 Drawing	Entity-RAY
The RAY command can create a line starts at a point 
and continues to infinity in any specified direction.

Command: RAY

Specify starting point: XI, YI

Specify through point: X2,Y2 (Fig 25)

Edge/ <Center of polygon>: 50, 50 
Inscribed in circle/Circumscribed about circle (I/C): I 
Radius of circle: 40

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.94
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TASK 1: 	Draw	the	following	figure	start	from	original	point	(0,0)	(Fig	1)

Absolute Coordinate System

Command: Rectangle

Command: fillet

Specify fillet radius for rectangles:20

Specify first corner point:0,0

Specify other corner point: 220,140

Command: Rectangle

Command: fillet

Specify fillet radius for rectangles:10

Specify first corner point:10,10

Specify other corner point: 210,130

Command: Rectangle

Command: chamfer

Specify first chamfer distance for rectangles:10

Specify second chamfer distance for rectangles:10

Specify first corner point:50,40

Specify other corner Point: 170,120

Command: Circle

Specify center point for circle: 25,25

Specify radius of circle:5

Command: Circle

Specify center point for circle:25,115

Specify radius of circle:5

Command: Circle

Specify center point for circle: 195,25

Specify radius of circle:5

Command: Circle

Specify center point for circle: 195,115

Specify radius of circle:5

TASK 2: Draw	the	following	figures	using	Auto	CAD	commands	(Fig	1)

Specify included angle:90

Command: a

Specify first point:10,0

Specify center point:5,0

Specify included angle:180

Command: a

Specify first point:0,10

Specify center point:5,10

Specify included angle: 180

TASK 3: Draw	the	following	figure	start	from	original	point	(0.0)	(Fig	1)

Absolute Coordinate System

Command: L

Specify first point:0,0

Specify next point:0,3

Command: L

Specify first point:2,0

Specify next point:2,3

Command: L

Specify first point:4,0

Specify next point:4,3

Command: L

Specify first point:6,0

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.94
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7

Specify next point:6,3

Command: a

Specify first point:0,0

Specify second point:1,-1

Specify end point:2,0

Command: a

Specify first point:4,0

Specify second point:5,-1

Specify end point:6,0

Command: a

Specify first point:2,3

Specify second point:3,4

Specify end point:4,3

Command: a

Specify first point:0,3

Specify second point:3,6

Specify end point:6,3

Command: C

Specify center point for circle: 1,0

Specify radius of circle:0.5

Command: C

Specify center point for circle: 5,0

Specify radius of circle:0.5

TASK 4: Draw	the	flowing	figure	start	from	original	point	(0,0)	(Fig	1)

Absolute Coordinate 

Command: Polygon

Enter number of side: 8

Specify center point :2,2

Specify radius of circle:2

Command: Polygon

Enter number of side: 8

Specify center point :6,2

Specify radius of circle:2

Command: Polygon

Enter number of side: 8

Specify center point :10,2

Specify radius of circle:2

Command: ellipse

Specify axis end point of ellipse:2,1

Specify other end point od axis:2,3

Specify distance to other axis:0.5

Command: ellipse

Specify axis end point of ellipse 6,1

Specify other end point od axis:6,3

Specify distance to other axis:0.5

Command: ellipse

Specify axis end point of ellipse:10,1

Specify other end point od axis:10,3

Specify distance to other axis:0.5

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.94
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Capital Goods & Manufacturing  Exercise 2.1.95 & 96 
Draughtsman Mechanical - Computer aided drafting practice  

Modify	2D	objects	using	break,	erase,	trim,	offset,	fillet,	chamber,	move,	copy,	
array, rotate, Hatch command
Objectives: At the end of this exercise you shall be able to
•	 practice	 the	 commands	used	 to	modify	 different	 objects	 using	AutoCAD	 like	move,	 copy,	 rotate,	 trim,	
Array,	Break,	Erase,	Offset,	Fillet,	Chamfer,	scale,	Hatch,	Insert	Block.

Requirements

Tools/Equipment/Machines
• Auto CAD 2018 or Higher version.

Modify:
The MODIFY command is used to modify the existing 
drawings or complete the drawing easily. AutoCAD 
drawings are rarely completed simply by drawing 
lines, circles etc. Most likely you will need to MODIFY 
these basic drawing objects in some way in order to 
create the image you need. AutoCAD provides a whole 
range of modify tools such as Move, Copy, Rotate and 
Mirror. A good understanding of the Draw commands 
is fundamental to the efficient use of Auto CAD. (Fig 1)

Modifying Entity-MOVE
The modify entity MOVE command is used to move 
an object from one place to another place in the work 
plane. (Fig 2)

Command: MOVE

Specify through distance.
Modifying Entity -COPY
The modify entity COPY command copies the selected 
objects and creates any number of copies on the 
workspace at specified distance with specified rotation. 
(Fig 3)
Command: COPY
Select an object to copy: 
Select a through point: 
Select through distance:
Esc to close command.

Esc - Escape key   

Modifying	Entity-ERASE

Fig 1

Fig 3

The modify entity ERASE command is used to delete 
an object or some part of the object from the drawing 
permanently. It can be also done by selecting an object 
and pressing delete button on the keyboard. (Fig 4)Select object to move:

Select through point:
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Command: ERASE

Select an object to erase:

Close the command.

Modifying Entity mirror:
The Modify command is used to create a mirror image 
of the subjected object. The symmetric objects can be 
easily created using this command. (Fig 5)

Select an object: 

Specify first point of mirror line: 

Specify second point of mirror line: 

Close the command.

Modifying Entity-TRIM
The modify entity TRIM command is remove the 
unnecessary parts of the drawing corresponding to the 
other drawing entities. It is also used to meet the edges 
of one object to the other in the drawings. (Fig 6)

Command: TRIM

Select the objects to trim: 

Trim unnecessary parts:

Close the command.

Modifying Entity-OFFSET

Command: OFFSET
Select the objects to offset: 
Specify offset distance: 
Specify direction to offset: 
Close the command.
Modifying	Entity-	ARRAY 
The modify entity ARRAY command creates the 
selected objects into a number of objects arranged in 
a specified order. ARRAY command can be used in two 
different ways.
a Rectangular array:
The rectangular array is used to create the selected 
objects into number of objects and arrange them in a 
rectangular order. (Fig 8)
Command: RA
Select the object:
Select number of rows: 
Specify distance between two consecutive rows:
Select number of Columns:
Specify distance between two consecutive columns:
Close the command:

b Polar array: 
The polar array is used to create the selected objects 
into number of objects and arrange them in a circular 
order. (Fig 9)

Command: PA

Select the object: 

Select number of rows: 

Specify distance between two consecutive rows:

Select angle of rotation:

Close the command.

The modify entity OFFSET command is used to 
OFFSET the objects through specified distances. This 
command duplicates the same object around itself with 
some distance. (Fig 7)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.95 & 96
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Modifying	Entity-ROTATE
The modify entity ROTATE command is used to 
rearrange the selected object in the required order or at 
the specified angle. (Fig 10)

Command: ROTATE

Select the object to rotate:

Specify the through point to rotate: 

Close the command.

Modifying	Entity-SCALE
The modify entity SCALE command is used to resize 
the selected objects to specified scaling ratio. This 
command is used to view the large objects into a 
considered size. (Fig 11)

Command: SCALE

Select an object to be scaled:

Specify scaling ratio:

Close the command.

Modifying Entity-STRETCH
The modify entity STRETCH command is used to 
strech the required object to the required length. This 
command is also used to make join one entity with the 
other. (Fig 12)

Command: STRETCH

Select an object to stretch:

Specify the distance or end object:

Close the command.

Modifying Entity-LENGTHEN
The modify entity LENGTHEN command is used to 
increase the length of the line command. (Fig 13)

Command: LENGTHEN

Select an object to lengthen: 

Specify the distance or end object.

Close the command.

Modifying Entity-EXTEND
The modify entity EXTEND command is used to 
extend the required object to the required length. This 
command is also used to make join one entity with the 
other. (Fig 14)

Command: EXTEND

Select an object to stretch:

Specify the distance or end object:

Close the command.

Modifying	Entity	-	BREAK
The modify entity BREAK command is used to create 
breaks in the objects. Any entity can be breaked at any 
place using this break command. (Fig 15)

Command: BREAK

Select an object to break:

Specify break position:

Close the command.

Modifying	Entity-CHAMFER
The modify entity CHAMFER command is used to round 
off the sharp edges of the object. (Fig 16)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.95 & 96
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Command: CHAMFER

Select an end to chamfer: 

Select the chamfer radius:

Close the command.

Modifying Entity-FILLET

Command: FILLET

Select an end to chamfer: 

Select the chamfer radius:

Close the command.

Modifying	Entity-HATCH
The modify entity HATCH command is used to define 
hatching to an object. Hatch is used to clearly identify 
the different parts of an object and different sectional 
views of object. Different types of hatches can be used 
by changing properties of hatch. (Fig 18)

Command: HATCH

Select the area to hatch:

Edit hatch properties:

Close the command.

The modify entity FILLET command is used to remove 
the sharp edges of the object. (Fig 17)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.95 & 96
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Capital Goods & Manufacturing  Exercise 2.1.97 
Draughtsman Mechanical - Computer aided drafting practice  

CAD:	Create	templates,	insert		drawing-create	objects	in	different	layers	and	
modify layer properties
Objectives: At the end of this exercise you shall be able to
• create a new template
• Interest a drawing
•	 creation	of	objects	in	different	layers.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

Layers	Definition	(Fig	1)
The way to gain complete layer control is through the 
Layer Properties Manager. . The Layer Properties 
Manager is invoked by:

1 Command line Window: Layer or LA

2 Tool Bar: format ↔Layer

3 layer properties manager:

Command:-Layer

Current Layer.”0”

Enter an option

[?/Make/Set/New/On/Off/Color/Ltype/Lweight/Plot/
Pstyle/Freeze/Thaw/Lock/Unlock/state]:

Fig 1

Layer Properties manager Layer List
The right central area of the layer properties manager 
is the layer list that displays the list of layers in the 
drawing. Here you can control the current visibility 

settings and the properties assigned to each layer. 
This list can display all the layers in the drawing or a 
subset of layers if a layer filter is applied. Layer filter are 
created and applied in the filter tree view on the left side 
of the layer properties manager. For new drawings such 
as those created from the AutoCAD, dwg template. only 
one layer may exist in the drawing layer “0”. New layers 
can be created by selecting the new layer button or the 
new layer option of the right click menu.

Steps of Create Layers (Fig 2)
1 Click  on the left of layer properties bar. The following 

dialog box appear.

2 Click (New), new raw adding to existing layers, we 
saw always there was first layer it is zero layer which 
created by AutoCAD Automatically when open new 
drawing. Appear in new raw name of new layer we 
can change it to objective name to easily access 
to layer we need, such as wall, column. steel, 
ground.......

3 To determine layer color click on black square under 
address (color) in new raw color window appear 
select from it appropriate color.

4 To determine line style click on (continuous) in new 
raw under address (line type). window appear, select 
from it appropriate line type click on (load) to appear 
more line types.

5 To determine line weight used for drawing objects 
click (default) under address (line weight) then select 
weight we need from the window that appear.

6 Repeat the operation for other layers then click (ok).
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Layers Managements
*Select drawing layer to be activate
1 Click on manager Layer List.

2 Select layer from it.

3 Click on drawing board the selected layer be the 
active layer note that object color and line type and 
line weight all must be assistant to( By layer).

*move drawing object from layer to another.
1 Select drawing object.

2 Click on manager Layer List to open it.

3 Select layer want to move the object to it.

4 Click on ESC twice to undo select object, we saw 
change the layer color and line to color of selected 
layer.

*hid objects belong to determine drawing layer. 
1 Click on manager Layer List to open it.

2 Click on yellow light for layer wants to hid it by put 
it to off then click on enter we obtain the drawing 
without the selected layer.

*lock	objects	belong	to	determine	layer.
1 Click on manager Layer List to open it.

2 Click on lock button for layer wants to lock it then 
click enter, the layer is locked. The locked layer it is 
the layer that can’t change or modified to it unless 
we open it by click the lock button again.

*change color of drawing layer.
1 Click on properties bar, the dialog box appear for 

control layers and lines types.

2 Click on color, color control box appear

3 Select appropriate color.

4 Click ok in two open boxes to close them we saw all 
the objects belong to the layer their color are change 
to new color.

TASK 1:  Setup	the	layers	shown	in	the	following	table,	then	create	the	house	shown	in	figure	(Fig	1)

Then apply the following:
• Hide layer windows.

• Lock layer door.

• Change layer walls color from yellow to pink.

Layer Name Color Line Type Line Weight

Walls Yellow Continuous 0.40mm

Windows blue Center2 0.20mm

Door red Continuous Default

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.97
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Capital Goods & Manufacturing  Exercise 2.1.98 
Draughtsman Mechanical - Computer aided drafting practice  

Dimensioning	by	Auto	CAD
Objectives: At the end of this exercise you shall be able to
•	 draw	the	techniques	of	the	dimensioning	in	Auto	CAD.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

Dimensioning:
The correct use of AutoCAD’s dimension tools is the key 
to producing clear and concise measured drawings. Any 
drawing is incomplete without specifying its dimensions. 
Dimensions are necessary to understand the drawings 
and also to manufacture is the parts in the drawings. 
In this experiment, we are going to learn how to use 
different types of dimensioning commands.

1 Linear Dimension command:
The LINENEAR DIMENSION command is used to 
generate the horizontal and vertical dimensions in the 
drawing. The dimensions of vertical and horizontal lines 
are represented in the drawing using this command. 
(Fig 1)
Command: DIMLINEAR
Select a line or first point:
Select end point:
Select dimension direction:
Close the command.

Select dimension direction:

Close the command

2	 Baseline	Dimension	command:
The BASELINE DIMENSION command is also used 
to generate the horizontal and vertical dimensions 
in the drawings. But the only difference is that every 
dimension is started from a fixed basic line unlike to 
linear dimension. (Fig 2)

Command: DIMBASELINE

Select the base line:

Select second point for dimension:

3	 Aligned	Dimension	command:
The ALIGNED DIMENSION command is used to 
generate the dimensions of the aligned lines and aligned 
portions of the drawings. By using this command, we 
can generate the dimensions of the aligned lines parallel 
to them. (Fig 3)
Command: DIMALIGNED
Select a line or first point:
Select end point:
Select dimension direction:
Close the command.

4 Diameter Dimension command:
The DIAMETER DIMENSION command is used to 
specify the diameter of the circles or ares that are 
present in the drawings. (Fig 4)

Command: DIMDIAMETER 
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Select the circle to annotate:

Close the command.

5 Radius Dimension command:
The DIAMETER DIMENSION command is used to 
specify the diameter of the circles or ares that are 
present in the drawings. (Fig 5)

Command: DIMDIAMETER

Select the circle to annotate;

Close the command.

6 Ordinate Dimension command:
The ORDINATE DIMENSION command is used to 
annotate co-ordinate points with X or Y values of any 
point in the drawing. This may be useful for setting-out 
on site plans. (Fig 6)

Command: DIMORDINATE

Select the point to dimension ordinates:

Close the command.

7	 Angular	Dimension	command:
The ANGULAR DIMENSION command is used to 
represent the angles of angular lines with respect to a 
base line in the drawings. (Fig 7)

Command: DIMANGULAR

Select base line:

Select the line to represent angle:

Close the command.

8 Dimension Text Edit command:
DIMENSION TEXT EDIT command is used to edit 
the text in the dimension. This command option is 
used to edit the dimension to represent the repetitive 
dimensions.

Command: DIMTEDIT 

Select the dimension to edit: 

Edit dimension:-

Close the command.

9 Dimension Edit command:
DIMENSOIN EDIT command is used to edit the 
properties of the dimensions such as dimension line 
type, line thickness, arrow size, text height etc. (Fig 8) 

Command DIMEDIT

Select the dimensions to edit properties:

Edit required properties:

Close the command.

AutoCAD	2D
Design	Center	Blocks	20.2
1 Choose: Blocks from one of the Design Center 

menus.

2 Drag: and drop a block from the Design Center into 
a drawing.

TIP:

•  Blocks with attributes will be prompted as they are 
inserted into the drawing.

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.98
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Fig 8

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.98
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Capital Goods & Manufacturing  Exercise 2.1.99 
Draughtsman Mechanical - Computer aided drafting practice  

CAD:	Construct	or	thographic	sectional	view	of	a	steel	bracket	with	dimension
Objectives: At the end of this exercise you shall be able to
•	 draw	the	sectional	view,	plan,	Elevation	using	CAD.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: 	Draw	the	sectional	view,	plan,	Elevation	using	CAD	(Fig	1)
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Capital Goods & Manufacturing  Exercise 2.1.100 
Draughtsman Mechanical - Computer aided drafting practice  

Construct	isometric	view	of	machine	blocks
Objectives: At the end of this exercise you shall be able to
• draw isometric view using orthographic view.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: 	Draw	isometric	view	using	orthographic	view	using	CAD	(Fig	1)
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Capital Goods & Manufacturing  Exercise 2.1.101 
Draughtsman Mechanical - Computer aided drafting practice  

Create view ports in layout Space
Objectives: At the end of this exercise you shall be able to
• create viewports in layout space
• place views for model space.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

Typing the View Command (Fig 1)
1 Type View at the command prompt  

  Command: -VIEW

2 Type One of the following view options:

   ?/Delete/Restore/Save/Window:

View options:
 ?   Lists the named views for this  
    drawing

Fig 1

 Delete  Deletes the named view

 Restore  Displays the specified view

 Save  Attaches a name to the   
    current view of the drawing

 Window  Attaches a name to specified  
    window

Plotting Named Views
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Viewports
Vports Command (Figs 2 - 5)
1 Choose View, Viewports, New Viewports...

2 Choose one of the viewports configurations

3	 Click	 OK.

4	 Click	 once in each vport to make it active.

5	 Туре	 a ZOOM option in each viewport.

Fig 5

Fig 3

Fig 2

Creating a Layout
1 Choose the Layout1 TAB at the bottom of the  
  screen.

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.101

Fig 4
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2	 Right-Click Layout 1 to change the name and  
  other properties of layout (Fig 6)

Fig 6

Model Space
MSPACE (model space) can only be activated if there 
is at least one review. To enter model space mode use 
“MSPACE”.

1 Type MSPACE at the command prompt.  
  Command: MSPACE	or	MS

 or

2	 Double-Click the word “PAPER” on the Status  
  Bar to toggle to model space. (Fig 7)

Notice the ucsicon will appear in each of the m views 
when you enter model space. (Fig 8)

Plotting in Paper Space (Fig 9)

Fig 9

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.101

Fig 7
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• Plotting all M VIEWS should be done from Paper 
Space not from Model Space.

• When you plot from P space, you should plot1=1.

• For hidden line removals, remember to use the 
HIDEPLOT option in the MVIEW command.

• Once a ZOOM SCALE has been defined, do not 
zoom again before plotting. You can change the 
display with the PAN command. (Fig 10)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.1.101
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Capital Goods & Manufacturing  Exercise 2.2.102 
Draughtsman Mechanical - Types of Pulleys 

Construct pulleys using CAD
Objectives: At the end of this exercise you shall be able to
• draw a solid pulley
• draw stepped pulley.

PROCEDURE

TASK 1:  Draw the solid pulley, stepped pulley using CAD (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.2.103 
Draughtsman Mechanical - Types of Pulleys 

Construct pulley with different types of arms
Objectives: At the end of this exercise you shall be able to
• construct pulley with arms.

PROCEDURE

TASK 1:  Construct pulley with arms using CAD (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.2.104 
Draughtsman Mechanical - Types of Pulleys 

Draw rope pulley and vee belt pulley using CAD
Objectives: At the end of this exercise you shall be able to
• draw rope pulley
• draw V belt pulley.

PROCEDURE

TASK 1:  Draw the rope pulley, V belt pulley using CAD (Figs 1&2)
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Capital Goods & Manufacturing  Exercise 2.3.105 
Draughtsman Mechanical - Pipe joints  

Draw pipe fittings  
Objectives: At the end of this exercise you shall be able to
• draw pipe fittings.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw pipe fittings (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.3.106 
Draughtsman Mechanical - Pipe joints  

Draw conventional symbols of different types of valves and joints used on 
pipe line diagram  
Objectives: At the end of this exercise you shall be able to
• draw symbols for pipe fittings
• draw the symbols for valves
• draw pipes layout systems.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the symbols shown in the table below

SL. 
No

Description Isometric symbol (right face) Orthographic symbol

Screwed Flanged Screwed Flanged 

1 Joint coupling

2 Reducer

3 90° elbow

i.Turned up

ii.Turned down

4 Tee

i.Turned up

ii. Turned down
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SL. 
No

Description Isometric symbol (right face) Orthographic symbol

Screwed Flanged Screwed Flanged 

5 Cross 

6 Bend

7 Cap (female) / 
(dead end)

8  Plug (male)

9 Union

10 Hose nipple

TASK 2: Draw the symbols shown in the table below

  Sl.    Description  Isometric symbol (right face)               Orthographic symbol

    Screwed    Flanged Screwed Flanged

  1      Gate valve (Ele.)

       Plan

  2      Globe valve (Ele)

       Plan

  3       Water tap

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.3.106
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  Sl.    Description  Isometric symbol (right face)               Orthographic symbol

    Screwed    Flanged Screwed Flanged

4      Angle valve (Ele)

       Plan

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.3.106
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Capital Goods & Manufacturing  Exercise 2.3.107 
Draughtsman Mechanical - Pipe joints  

Draw the piping layout system
Objectives: At the end of this exercise you shall be able to
• draw piping layout system from sump to a over head tank.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the water supply gravity system shown in figure with suitable dimensions (Fig 1)

TASK 2: Draw the assemble view of the water tank with suitable dimensions shown in (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.3.108 
Draughtsman Mechanical - Pipe joints  

Draw the sectional view of different types of pipe joints
Objectives: At the end of this exercise you shall be able to
• draw the different types of pipe joints.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw collar joint

Collar joint (Fig 1)

D (Diameter of pipe) = 50 cm

t = (Thickness of pipe) = 5 cm

TASK 2: Draw the typical pipe joints

Draw the pipe joints as per given drawing

D = Diameter of pipe 10 cm

t = Thickness of pipe 1 cm (Figs 1 to 6)
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TASK 3: Draw the cast iron for two 100 mm diameter (Fig 1)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.3.108
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TASK 4: Draw full size two views of an union joint for 25 mm diameter pipes (Fig 1)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.3.108

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



35

Capital Goods & Manufacturing       Exercise 2.4.109 
Draughtsman Mechanical - Gears and cams  

Gears 
Objectives: At the end of this exercise you shall be able to
• gear calculation
• construction of base circles
•	 construct	tooth	profile	of	a	spur	gear	above	30	teeth
• draw two spur gear in mesh

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

Gear calculation (Fig 1)

Pitch diameter and number of teeth can also be found 
out from this relation.

Number of teeth or pitch circle diameter can also found 
from this relation

N = P.C.D x D.P

and 

Π=×
Π×

=×
P.C.D

N
N

  P.C.D  D.P  C.P

and 
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Module pitch or metric module is generally used in metric 
system.

Metric module,

Outside Diameter = Pitch diameter + 2 x addendum.

Root Diameter = Pitch Diameter - 2 x Dedendum

Clearance = Dedendum - Addendum

Exercise 2: Layout a pair of spur standard gears, given 
the following data:

Number of teeth on large gear = 24

Number of teeth on small gear = 16

Metric module m = 8

Width of space =  
2

C.P

Exercise :1 Construct tooth profile of a spur gear above 
30 teeth (Fig 2)

1 Construction of gear teeth suitable for gears of 30 teeth 
and above pressure angle 14.5°

Gear data - Metric module (m) 6; Number of teeth 30

Calculation data

Pitch circle diameter (P.C.D) = N x m = 30 x 6 = 180 mm

Addendum = m = 6 mm

Circular pitch (C.P) - p .m = 3.142 x 6 = 18.852 mm

Clearance =

Dedendum = Addendum + Clearance

       =6 + .9426 = 6.9426 mm

Tooth thickness = C.P/2 = 9.426 mm

Pressure angle f = 20°

Calculations

Large gear (Fig 3)

P.C.D = m x N = 8 x 24 = 192 mm

C.P = p x m = p x 8 = 25.133 mm

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.4.109
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 Add  =

 Add. Circle dia  = P.C.D + 2 x 8

  = 192 + 16 = 208 mm

 Clearance  =

 Dedendum  = Add. + Clearance

  = 8 + 1.257 = 9.257 mm

 Ded. Circle Dia.  = P.C.D - 2 x Ded.

  = 192 - 2 x 9.257

  = 173.49 mm

 Tooth thickness  = 

 Small Gear

 P.C.D.  = 8 x 16 = 128 mm

 C.P  = p x 8 = 25.133 mm

 Addendum  = 8 mm

 Add. Circle Dia.  = P.C.D + 2 x Add.

   = 128 + 16 = 144 mm

 Clearance  = 1.257 mm

 Dedendum  = 8 + 1.257 = 9.257 mm

 Ded. Circle Dia.  = P.C.D. - 2 x Ded.

  = 109.486 mm

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.4.109
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Exercise :3 Construct of bevel gear teeth to the given 
date gear data: 

Number of teeth 15 pitch cone angle 15°pitch circle dia 
105mm pressure angle 14.5°illustration drawing given 
below. (Fig 4)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.4.109
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Exercise :4 Draw a Bevel gear 

Draw front and top view of a bevel gear having the fol-
lowing the specification (Fig 5)

No. of teeth = 25

C.P = 25 mm

Face width = 57 mm

Pitch cone angle = 70°

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.4.109
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Capital Goods & Manufacturing  Exercise 2.4.110 
Draughtsman Mechanical - Gears and cams  

Construct	involute	tooth	profile	of	a	gear	
Objectives: At the end of this exercise you shall be able to
•	 draw	involute	profile	of	gear	using	CAD.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1:	Draw	involute	profile	of	gear	using	CAD

1  Construction for approximate involute
Describe the base circle. Cut-off any number of equal 
spaces along the base circle, i.e, A-1, 1-2, 2-3 etc. Join 
these points with the centre of the base circle. Draw 
tangents to the base circle from these points. Now with 
centre 1 and radius equal to 1A draw an arc to cut the 
first tangent at 1’. Again with 2 as centre and radius equal 
to 2 A draw an arc to cut the second tangent at 2’ and so 
on. The Curve joining 1’, 2’, 3’ etc. Will be the involute 
curve (Fig 1).

2		 Approximate	constructions	for	the	involute	tooth	
profile

Since accurate drawing of actual involute curves on the 
gear teeth is a lengthy procedure, it is usual to represent 
those involute curves approximately by circular arcs.

Four such approximate methods are shown here in 
Fig1,Fig 2, Fig 3. The first two methods differ only at one 
point, depending on the number  of teeth on the gear. 
First draw the pitch circle of diameter D and a tangent to 
it to fix the pitch point. On the pitch circle radius draw a 
semi circle of radius D/4 to cut a P an arc of radius D/8 
drawn with the pitch point as centre. On this circle lie the 
centres of the profile arcs of the teeth Fig 1, Then draw 
the addendum and dedendum circles and from the pitch  
point mark off tooth widths C.P/2 around the pitch circle. 
From these points draw arcs of radius D/8 to the circle 
for the centres of the profile areas. Then:

1   For a gear of 30 teeth and over (Fig 1) draw the profile 
arcs radius D/8 with these points as centres from the 
addendum circle to the Dedendum circle and complete 
the teeth with fillet radii equal to one-seventh of the 
widest tooth space.

2   For a gear with less than 30 teeth draw the profile 
arcs as in 1 above and draw radial lines tangential to 
them before adding the fillet radii. This method avoids 
 having teeth, which appear to be excessively undercut.

3   The third method can be used for a gear having any 
number of teeth  and makes use of the base circle. 
This construction is more suitable for teeth 20° pres-
sure angle than the methods described in 1 and 2 as 
it produces teeth which have wider roots Fig 3.

•  Draw the pitch, addendum and dedendum circles, 
and the base circle tangential to the line of action.

•  On a convenient radial line, fix a point A on the 
addendum circle and a point E on the base circle.

•  Divide AE into three equal parts and through B, 
the division nearest A, draw a tangent to the loose 
circle at D.
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•  Divide BD into four equal parts and through F, the 
division nearest to F draw circle. The centre for F 
is the centre for the profile arc passing through B.

•  From C, the intersection of this profile arc and the 
pitch circle, mark off teeth thickness round the 
circle.

Construction of gear teeth suitable for gears of 30 teeth 
and above pressure angle 14.5°

Gear data - Metric module (m)6; Number of teeth 30

Calculation Data
Pitch circle diameter (P.C.D) = N x m = 30 x 6 = 180 mm

Addendum = m = 6 mm

Circular pitch (C.P) = m = p x 6 = 18.852

 

Dedendum = Addendum + Clearance

                  = 6 + 0.9426 = 6.9426

Tooth thickness = C.P/2 = 9.426 mm

Addedum circle dia = PCD + 2 × Addendum

Dedendum circle dia = PCD - 2 × Dedendum

0.9426

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.4.110
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3   Construction of gear teeth using base circle as a 
basis of construction

Gear data - Pressure angle 20°, Metric module (m)10, 
number of teeth 25.

Calculation data
Pitch circle Diameter = D = m.N. = 10 x 25 = 250 mm

Addendum = m = 10mm

Clearance = C.P/20 = 31.42/20 = 1.571 mm

Dedendum = Addendum + Clearance = 10 + 1.571  
                                                                 = 11.571 mm

Tooth thickness = C.P/2 = 31.42/2 = 15.71 mm

Addedum circle dia = PCD + 2 × Addendum

Dedendum circle dia = PCD - 2 × Dedendum

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.4.110
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Capital Goods & Manufacturing  Exercise 2.4.111&112 
Draughtsman Mechanical - Gears and cams  

Draw	a	symmetrical	cam	profile										
Objectives: At the end of this exercise you shall be able to
•	 draw	cam	profile.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1:	Draw	cam	profile	(Fig	1)

1   Construct a plate cam nith knife edge follower to 
the given data

Cam data: 0° - 180° Lift 25 mm with S.H.M,

240  ° - 360° Fall 25 mm with acceleration and retardation 
at uniform rate. Rotation of CAM Anti - Clockwise

Least Thickness of metal around CAM centre 41 mm. 
Dia of camshaft 24 mm.
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TASK 2:	Construct	a	cam	profile	with	inline	roller	follower	to	the	given	data

A cam, with a minimum radius of 25 mm, rotating clock-
wise at a uniform speed is to be designed to give a roller  
follower, at the end of a valve rod, motion described below:

1   To raise the valve through 50 mm during 120° rotation 
of the cam;

2   To keep the valve fully raised through next 30°;

3   To lower the valve during next 60°; and

4  To keep  the valve closed during rest of the revolution 
i.e.150°;

The diameter of the roller is 20 mm and the diameter of 
the cam shaft is 25 mm.

Draw the profile  of the cam when (a) the line of stroke of 
the valve rod passes through the axis of the  cam shaft, 
and (b) the line of the stroke is offset 15 mm from the  
axis of the cam shaft.

The displacement of the valve, while being raised and 
lowered, is  to  take place with simple harmonic motion. 
Determine the maximum acceleration of the valve rod 
when the cam shaft rotates at 100 r.p.m.

Draw the displacement, the velocity and the acceleration 
diagrams for one complete revolution of the cam.

Solution: Given: S = 50 mm = 0.05 mm; qO = 120° = p/3 
rad = 2.1 rad; qR = 60° = p/3 rad = 1.047; N = 100 r.p.m

Since the valve is being raised and lowered with simple 
harmonic motion, therefore the displacement diagram, 
as shown in Fig 1, is drawn in the similar manner as 
discussed in the previous example.

a			 Profile	of	the	cam	when	the	line	of	stroke	of	the	
valve rod passes through the axis of the cam shaft

The profile of the cam, as shown in Fig 1 is drawn as 
discussed in the following steps:

1  Draw a base circle with centre O and radius equal to 
the minimum radius of the cam (i.e. 25 mm).

2   Draw a prime circle with centre O and radius,

8   From the points A, B, C....N,P, draw cricles of radius 
equal to the radius of the roller.

9  Joint the bottoms of the circles with a smooth curve 
as shown in Fig 1. This is required profile of the cam.

b		 Profile	of	the	cam	when	the	line	of	stroke	is	offset	
15 mm from the axis of the cam shaft

The profile of the cam when the line of stroke is offset 
from the axis of the cam shaft, as shown in Fig 1, may 
be drawn as discussed in the following steps:

1   Draw a base circle with centre O and radius equal to 
25 mm.

2   Draw a prime circle with centre O and radius OA = 35 
mm.

3   Draw an off-set circle with centre O and radius equal 
to 15 mm.

4   Join OA . From OA draw the angular displacement 
of cam i.e. draw angle AOS = 120° angle SOT = 30° 
and angle TOP = 60°.

5   Divide the angular displacements of the cam during 
raising and lowering of the valve into the same number 
of equal even parts(i.e. six parts) as in displacement 
diagram.

6   From points 1,2,3 .... etc and 0’, 1’, 3’, .... etc. on the 
prime circle, draw tangents to the offset circle.

7   Set off 1B, 2C, 3D..., etc. equal to displacements as 
measured from displacement diagram.

8   By joining the points A, B, C .... M, N,P, with a smooth 
curve, we get a pitch curve.

9   Now A, B,C ... etc. as centre, draw circles with radius 
equal to the radius of roller.

10  Join the bottoms of the circles with a smooth curve 
as shown  in Fig 1. This is the required profile of the 
cam.

Maximum acceleration of the valve rod 
We know  that angular velocity of the cam shaft, 

3   Draw angle AOS = 120° to represent raising or out 
stroke of the valve, angle SOT = 30° to represent dwell 
and angle TOP = 60° to represent lowering or return 
stroke of the valve.

4   Divide the angular displacements of the cam during 
raising and lowering of the valve (i.e. angle AOS and 
TOP) into the same number of equal even parts as 
in  displacement diagram.

5   Join the points 1,2,3 etc. with the centre O and produce 
the lines beyond prime circle as shown in Fig 1.

6   Set off 1B, 2C,3D etc. equal to the displacements 
from displacement diagram.

7   Join the points A, B,C ...N,P,A. The curve drawn 
through these points is known as pitch curve.

We also know that maximum velocity of the valve rod to 
raise valve,  

and maximum velocity of the valve rod to lower the 
valve,                

The velocity diagram for one complete revolution of the 
cam is shown in Fig 1. We know that the maximum ac-
celebration of the valve rod to raise the valve, 
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TASK 3: Design an edge cam to the following particulars (Fig 1)

•  Minimum distance of centre of cam from edge of 
follower 60 mm, lift 56 mm. The cam is to lift the fol-
lower with simple harmonic motion during one half of 
revolution, and then allows it suddenly to drop halfway, 
then to fall with uniform motion during the remaining 
half of the revolution.

•  Construction: Through O draw intersecting cen-
trelines. Mark off OA = 60 mm, AB = 56 mm. On AB 
describe  a semicircle and divide its circumference 
into six equal/sets. From each of these drop a perpen-
dicular to AB. We thus, divide the circumference into 
six equal parts from each of the drop a perpendicular 

to AB. Thus we divide rise •into parts proportional to 
harmonic motion. This harmonic motion applies to 180° 
therefore divide the first 180° in the same number of 
angular parts (six in this case) as was chosen when 
dividing the lift. Let these radii intersect the arcs from 
points 1 to 6 ( on the lift) in points P1 and P6. Draw 
smooth curve through these points.

•  Mark off CD equal to half AB. The curve form D to A 
is part of an Archimedean spiral. For uniform motion 
the follower must rise or fall through equal distance 
for equal angles of rotation by the cam.

and maximum acceleration of the valve rod to lower the 
valve,  

The acceleration diagram for one complete revolution of 
the cam is shown in Fig 1.
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TASK 4:	Layout,	full	size,	the	profile	of	a	plate	cam	to	give	an	offset	flat	follower	the	specified	motion	(Fig	1)

•  0° - 180° lift of 50mm with uniform velocity.

•  180° - 240° dwell.

•  240° - 360° fall of 50 mm with uniform acceleration 
and retardation.

•  The follower line of action is offset by 18 mm to the 
left of the cam shaft centre. The neatest approach of 
the follower face to the camshaft centre is 36 mm and 
the cam rotates anticlockwise.

TASK 5:	Construct	a	plate	cam	profile	with	an	offset	roller	follower	to	the	given	data	(Fig	1)

CAM	data:	Rotation	of	cam	clockwise
•  Dia of camshaft 26 mm. Nearest approach of roller 

centre to cam centre 40 mm.

•  Line of action of follower offset 20 mm to right of cam 
C/L Roller follower f 20.

•  0° - 105° Lift 25 mm with uniform velocity. 105° - 150° 
Dwell period

•  150° - 240° Lift 13 mm S.H.M.,

•  240° - 360° Return to start position with uniform 

•  Acceleration and retardation
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TASK 6: Construct	profile	of	a	cam	with	follower

•  Determine the profile of a cam, which allow the fol-
lower to oscillate with uniform angular velocity about 
a fixed centre. Every revolution of the cam completes 
one oscillation of the follower. Distance between the 
centre of cam and the roller is 35 mm, Lift = 75 mm, 
roller diameter = 12 mm, lever FC - 154 mm.

•  Construction: Fig 1 with centre O and radius OF = 
140 mm describe a circle. Starting from F divide its  
circumference into 16 equal parts. From each of 
these parts in turn, describe arcs passing through O. 

Locate point C, the centre of roller. Set-off the lift and 
divide it into eight equal parts. Describe concentric 
circles through each of the points. The successive 
points of intersection between these circles and the 
arcs previously drawn are on the locus of the roller 
centre. Draw the arcs, from the points of intersection 
of circles and arcs, with radius equal to radius of the 
roller. A smooth curve touching all these curved arcs 
gives the profile of the cam
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Capital Goods & Manufacturing  Exercise 2.5.113 
Draughtsman Mechanical - IC Engine parts and Assembly  

Construct detailed and Assembly drawing 
Objectives: At the end of this exercise you shall be able to
• draw eccentrics
•	 draw	stuffing	box
• draw piston assembly
• draw Ic engine connecting rod.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Construct detail and assembly drawings of an Eccentrics using CAD (Figs 1 -3)
In assemble drawing draw the following views

i Top half - sectional elevation

ii End view
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TASK 2:	Construct	detail	and	assembly	drawings	of	an	stuffing	box	using	CAD	(Fig 1)

In assemble drawing draw the following views

i Left half - sectional elevation

ii Top view
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TASK 3: Construct detail and assemble drawings of piston assembly using CAD (Figs 1&2)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.5.113

In assemble drawing draw the following views

i Full sectional elevation

ii Top view
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TASK 4: Construct detail and assemble drawings of IC Engine connecting rod using CAD (Fig 1)

In assemble drawing draw the following views

i Sectional elevation

ii Top view
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Capital Goods & Manufacturing  Exercise 2.5.114 
Draughtsman Mechanical - IC Engine parts and Assembly  

Construct detailed drawing of an Air valve 
Objectives: At the end of this exercise you shall be able to
• draw the detailed drawing of the air valve.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Construct detail and assemble drawings of Air valve using CAD (Figs 1&2)

In assemble drawing draw the following views

i Full sectional elevation

ii Top view
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Capital Goods & Manufacturing  Exercise 2.5.115 
Draughtsman Mechanical - IC Engine parts and Assembly  

Fuel injector of diesel Engine
Objectives: At the end of this exercise you shall be able to
• draw detailed drawing of the fuel injector.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Construct detail and assemble drawings of fuel injector using CAD (Figs 1&2)
In assemble drawing draw the following views

i Half sectional elevation.
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Capital Goods & Manufacturing  Exercise 2.6.116 
Draughtsman Mechanical - 3D Solid objects 

3D Modelling
Objectives: At the end of this exercise you shall be able to
• draw 3D primitives  
• create co ordinate system 
• annotate and dimension of the 3D model
• generate views from model space to layout 
• generate print preview.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Creating solids using basic shapes

AutoCAD provides seven basic solid shapes. Basic 
shapes will be our first step to create more complex 
shapes. To find all of these commands go to the Home 
tab, locate the Modeling panel, and select one of the 
following:

Here is a discussion of each command.

Box Command

This command will allow you to create a box or cube. 
Choose the Box command; the following prompts will 
be displayed:
Specify first corner or [Center]:
Specify other corner or [Cube/Length]:
Specify height or [2Point]:
To draw a box in AutoCAD, you have to define the base 
first, then the height. The base will be drawn on the cur-
rent XY plane. Some variations include:
•  Specify the base by typing the coordinates of the first 

corner, and the coordinates of the opposite corner.
•  Specify the base by typing the coordinates of the first 

corner. To specify the opposite corner, specify the 
length and height using typing and [Tab] key.

•  Specify the base by specifying the first corner; then 
specify Length (in X axis direction) and Width (in Y 
axis direction).

•  Specify the base by specifying the first corner; then 
specify Cube option. Auto- CAD will ask you to input 
one dimension for all the sides (length, width, and 
height).

•  Specify the base by specifying Center point and one 
of the corners of the base. After specifying the base, 
specify the height, either by typing, by using the mouse, 
or by specifying two points by clicking (this is a good 
method if you have an existing object). (Figs 1&2)

Fig 1

Note:From now on, you can use dynamic input 
to input all or any of the distances needed to 
complete any command.

Fig 2

Cylinder Command (Fig 3)
This command will allow you to create a cylinder. Choose 
the Cylinder command and the following prompts will 
appear:
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Specify center point of base or [3P/2P/Ttr/Elliptical]:

Specify base radius or [Diameter]:

Specify height or [2Point/Axis endpoint]:

To draw a cylinder in AutoCAD, you have to define the 
base first, then the height. Some variations include:

•  The base could be a circle or ellipse. The options to 
draw either a circle or ellipse are identical to the 2D 
prompts. The base will be drawn on the current XY 
plane.

•  After defining the base, specify the height, either by 
typing or by using the mouse or by using 2 Points 
option (using the height of an existing object).

Axis endpoint option will allow you to rotate the cylinder 
by 90 degrees to make the height in the XY plane and 
not perpendicular to it. Using Polar option you can direct 
the cylinder as you wish.

Fig 3

Cone Command (Fig 4)
This command will allow you to create a cone. Choose 
the Cone command and the following prompts will be 
displayed:

Specify center point of base or [3P/2P/Ttr/Elliptical]:

Specify base radius or [Diameter):

Specify height or [2Point/Axis endpoint/Top radius):

Cone and Cylinder have identical prompts; hence, we will 
not discuss them again, except for one thing. The Cone 
command will allow you to draw a cone with Top radius.

Fig 4

Sphere Command (Fig 5)
This command will allow you to create a sphere. Choose 
the Sphere command and the following prompts will 
appear:
Specify center point or [3P/2P/Ttr]:
Specify radius or [Diameter]:
These prompts are identical to Circle command prompts.

Fig 5

Pyramid Command (Fig 6)
This command will allow you to create a pyramid. Choose 
the Pyramid command and the following prompts will 
appear:

4 sides Circumscribed
Specify center point of base or [Edge/Sides]:
Specify base radius or [Inscribed]:
Specify height or [2Point/Axis endpoint/Top radius]:
The default is 4-sides base. You can change the number 
of sides by selecting the Sides option. To draw a base, use 
the same methods to draw a 2D polygon. Height options 
were discussed in the previous commands. The example 
below is for a 4-sides base with the top smaller polygon:

Fig 6

To issue this command, go to the Solid tab, locate the 
Solid panel, and select the Extrude button, or go to the 
Surface tab, locate the Create panel, and select the 
Extrude button: (Fig 7)

Fig 7
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The following prompts will be shown:
Select objects to extrude or (Mode]:
Specify height of extrusion or [Direction/Path/Taper angle]
The first line is asking you to select object(s) to extrude. 
The second line says:
Specify height of extrusion or [Direction/Path/Taper angle]
This line will tell you there are four ways to create an 
extrusion in AutoCAD:

•  Specify a height. 

•  Specify a direction.

•  Specify a path.

•  Specify a taper angle.

Create an Extrusion Using Height (Fig 8)
This is the default option; it will create an extrusion 
perpendicular to the 2D profile using height. Whenever 
you select the 2D object, edge, or face, you will see 
the extrusion in the screen. You can specify the height  
graphically, or you can type the height value. See the 
following:

Fig 8

Create an Extrusion Using Direction (Fig 9)
If option height is to create an extrusion perpendicular 
on the profile, this option will create an extrusion with 
any angle desired. The following prompts will be shown:

Specify start point of direction: Specify end point of 
direction:

The following picture clarifies the concept:

Fig 9

Using loft command (Figs 10&11)
This command will create a solid or surface by using  
multiple cross sections in different UCSs whether opened 
or closed. The condition here is to have all profiles opened 
or all of them closed; you cannot use a mix. You can use 
different options like guide, path, and cross sections. To 
issue this command, go to the Solid tab, locate the Solid 
panel, and select the Loft button, or go to the Surface 
tab, locate the Create panel, and select the Loft button:

Fig 10

The following prompts will be displayed:

Select cross sections in lofting order or [Point/Join  
multiple edges/Mode]:

The first line will ask you to select the cross sections in 
lofting order. Refer to the following example:

Fig 11

This prompt will be repeated to select more and more 
closed or opened objects. While you are selecting, you can 
select one of three more options. They are the following:

•  Point, which will allow you to select the loft end point 
and end the command at this point. The cross section 
selected should be always closed, and you should 
specify this point either by typing a real 3D point or 
by selecting a point object. You will see the following 
prompt:

Specify loft end point: (Fig 12)

Fig 12

Lofting Using Path (Fig 13)
You have the ability to select cross section alone, but 
with this option, users will select both cross sections and 
path to dictate the final shape. The following prompt will 
be shown:

Select path profile:

You should receive the following:

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.6.116

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



63

Fig 13

Using revolve command (Figs 14 & 15)
This command will create a solid or surface by revolving 
2D objects closed or opened, or using the face or edge 
of solids and surfaces. To issue this command, go to the 
Solid tab, locate the Solid panel, and select the Revolve 
button, or go to the Surface tab, locate the Create panel, 
and select the Revolve button:

The following prompt will be shown: Select objects to 
revolve or [Mode]:

Fig 14

AutoCAD is asking you to select the desired object(s) to 
revolve When done press [Enter]; the following prompts 
will be shown:

Specify axis start point or define axis by

[Object/X/Y/Z] <Object>:

Specify angle of revolution or

[STart angle/Reverse/Expression] <360>:

AutoCAD is offering three different methods to specify 
the axis of revolution. They are the following:

•  Specify an axis by inputting two points

•  Specify an axis by selecting a drawn object.

•  Specify an axis by specifying one of the three axes.

Finally you have to specify the angle of revolution, there 
are multiple options here.

•  Input the angle either by typing or by using the mouse. 
CCW is always positive. If you define the axis of revo-
lution by two points, then the positive angle will be the 
curling of your right hand, with your thumb pointing to 
the direction of the nearest point to the farthest point.

•  Specify the start angle if you want the revolving  
process to start not from the cross section.

•  If you want to reverse the direction of the angle, use 
Reverse option.

The following illustration will explain the concept:

Fig 15

Using sweep command (Figs 16 - 18)
This command will create complex a solid or surface by 
sweeping a 2D open or closed shape, or a solid or surface 
face or edge along a path. To issue this command, go 
to the Solid tab, locate the Solid panel, and select the 
Sweep button, or go to the Surface tab, locate the Create 
panel, and select the Sweep button

Fig 16

The following prompts will be shown:

Select objects to sweep or [Mode]:

Select objects to sweep or [Mode]:

Select sweep path or [Alignment/Base point/Scale /Twist]:

The default option is to select object(s) to sweep, 
then select the sweep path if you follow this path. The  
following is a result of what you will receive:

Or you can use the other options which are the following:

•  Alignment

•  Base point

•  Scale

•  Twist

Fig 17
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Fig 18

TASK 2: Creating a new UCS using UCS command

This command will create a new UCS based on  
information supplied by you, and it does not ask for ob-
jects to be drawn before hand. This command offers so 
many ways to create a new UCS, which makes it a very 
important command for any AutoCAD user who wants to 
master 3D modeling in AutoCAD. We will discuss UCS 
options not according to their alphabetical order, but ac-
cording to their importance. You can find all UCS options 
in the Home tab and Coordinates panel. (Fig 1)

3-Point Option
  To create any plane in XYZ space, you need three 

points. This fact makes this option the most practical 
when creating a new UCS. As the name of the option  
suggests, you will specify three points:

1  New origin point

2  Point on the positive X axis

3  Point on the positive Y axis

To issue this command, select the 3-Point button:

Fig 1

Origin Option (Fig 2)
This option will create a new UCS by moving the origin 
point from one point to another without modifying the 
orientation of the XYZ axes. To issue this command, 
select the Origin button:

Fig 2

X/Y/Z Options (Fig 3)
These are three options but they are similar. So, we put 
them together. The idea is very simple; you will fix one of 
the three axes, and then rotate the other two to get a new 
UCS. But how will you know whether the angle you have 
to input should be positive or negative? We will use the 
second right-hand-rule, which states, “Point the thumb 
of your right hand toward the positive portion of the fixed 
axis; the curling of your four fingers will represent the 
positive direction.” In the below picture we took Y as an 
example. To issue the Y command, select the Y button.

Fig 3

Named Option (Figs 4 -7)
If you use a certain UCS a lot, AutoCAD gives you the  
ability to name/save it. This will help you retrieve it when-
ever you need it. After creating the UCS, go to the View tab, 
locate the Coordinates panel, select the Named button:

Fig 4

You will see the following dialog box:

Under the Named UCSs tab, you will see a list of the 
saved UCSs, plus, Unnamed, World, and Previous.  
Unnamed is your current UCS, which you created before 
issuing this command. Click it to rename it; then type the 
new name. Then press [Enter]. You will see the following:
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Fig 5 To end the command, click OK.

In the Coordinates panel, there is a list of the preset UCS. 
You will see your saved UCS among them, as shown in 
the following.

Fig 6

Fig 7

TASK 3: Annotate or dimension a 3D object in auto CAD

•  Dimension using 3D Snaps 

•  Replace the Z value with the current elevation in the 
layout:

1  Open the OPTIONS dialog.

2  Switch to the Drafting Tab.

3  At the bottom of the window, check Replace Z  
 value with current elevation.

4  Press OK. 

•  Place dimension using UCS: 

1  Go to Home Tab

2  Hover to mouse to Coordinates panel 

3  Click on Origin UCS 

4  Place the UCS on the object face where the   
  dimension needs to be added 

5  Go to Annotate Tab

6  Click on Dimension 

7  Place the dimension where are needed

TASK 4: Model documentation - Introduction
Model Documentation will generate intelligent  
documentation for AutoCAD 3D models. Model Documen-
tation will generate views, sections, and details that will 
be instantly updated when the model changes. In order to 
start working with this tool, you should go to any layout; 

then you will find all the desired panels in the Layout tab 
(which will appear only if you are in Layout and not in 
the Model space). They are: Create View, Modify View, 
Update, and Style and Standards. (Fig 1)

Fig 1
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The procedure is very simple:

•  Create Base view.

•  Create Projected views.

•  Create Sections and Details.

•  Edit and update the views.

•  Control Styles and Standards.

Model documentation - Create base view (Fig 2)
This should be always your first step. If you have more 
than one 3D model, AutoCAD will allow you to select the 
desired objects to be included in the creation process. 
You can start your step from the Model space or you can 
go to the desired layout. To start this command, go to 
the Layout tab, locate the Create View panel, and select 
the Base button:

Fig 2

You will have two choices to choose from:

•  The current From Model Space.

•  From Inventor. This option will allow you to bring in 
Inventor file (*.iam, *.ipt, or *.ipn).

Let’s assume that you want to bring 3D objects from 
AutoCAD created in the Model Space. In this case, we 

have two choices:
•  Start the command in Model Space. AutoCAD will ask 

you either to select the desired objects to include in 
the view/section/detail, or select the entire model.

Because you are in the Model Space, AutoCAD will ask 
to specify the name of the layout to be used. You will see 
the following prompts:
Select objects or [Entire model] <Entire model>: Enter 
new or existing layout name to make current or [?] <Lay-
out1>: layout1
Start the command in one of the layouts. AutoCAD will 
ask you to specify the location of the base view. The most 
important thing at this stage is Select option. By default 
AutoCAD will select all objects in the Model Space; once 
you start the Select option, you will be taken to Model 
space to remove the undesired objects. When done, 
AutoCAD will take you back to the layout you were in. 
You will see the following prompts:
Type Base only Hidden Lines Visible and hidden lines
Scale = 1/8” = 1’-0”
Specify location of base view or [Type/s Elect/ Orienta-
tion/ Hidden lines/Scale/Visibility] <Type>:
Meanwhile, a new context tab named Drawing View 
Creation will appear. It appears as the following:
At the left you can see the Model Space Selection button, 
which is identical to the Select option we discussed above.
The Default view will appear. You can change the default 
view to your desired view, which will act as your Base 
view using two methods. The first is Using the Orientation 
panel in the context tab, which will allow you to select 
the desired view. The second is to use the Orientation 
option in the prompts above. (Fig 3)

Fig 3

By default, using the Base command will insert the base 
view and the Projected views, as well. But using the Type 
option, users can select whether to insert Base or Base 
and Projected.

Using the Appearance panel in the context tab will allow 
you to pick the Hidden Lines settings. You will select one 
of four: Visible lines, Visible and hidden lines, Shaded 
with visible lines, and Shaded with visible and hidden 
lines. Also, using the same panel, you can set the scale 
and the edge visibility. (Fig 4)

Fig 4

Assuming the inserted only the base view, you will see 
the following:
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Fig 3

Fig 4

Fig 5

Fig 6

TASK 5: Named views and 3D

Users normally use all 3D viewing commands to look at 
the desired model from different angles. While using this 
command, you can save and name the views to look at 
them later or to use them in layouts for printing purposes. 
To issue this command, go to the Visualize tab, locate 
the Named Views panel, and select the New View button:

The following dialog box will be shown: (Figs 1&2)

Fig 1

Fig 2

First type in the View’s name. Users can save with the 
view several things, they are:

•  The current layer status

•  The current UCS

•  The current Live section

•  The current visual style

Users can add a background to the saved view; select 
one out of the five different choices: (Fig 3)

A dialog box will appear for you to manipulate the relative 
parameters of each one of the five selections. Once you 
have finished, click OK to end the command.

To control your views, go to Visualize tab, locate Named 
Views panel, and click View Manager button, you will see 

the following dialog box. which contains a list of saved 
views: (Fig 4)

Another place you will see a list of the saved views is 
the Named Views panel; see the following image (Fig 5)

3D and viewport creation (Fig 6)
In this part, we will discuss the special features of 3D in 
viewport creation. To issue this command, you should be 
in one of the layouts, go to the Layout tab, locate Layout 
Viewports; then click the New Viewports button:

You will see the following dialog box:

Change the setup to 3D, set a named viewport, and then 
set the visual style for each viewport. When done click 
OK, and specify two opposite corners for the viewports, 
you will receive the following:

User can assign a shade mode to one or all viewports. 
Select the desired viewport; then right click, select shade 
plot, and select one of the modes as shown below:
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Fig 7

Fig 8

Notice the last group of the shade plots. They are  
rendering options; hence you can plot a rendered image 
if you want, but you can only see the effects of this action 
using the print preview command. (Figs 7 - 9)

Fig 9
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Capital Goods & Manufacturing  Exercise 2.7.117 
Draughtsman Mechanical - Detailed and assemble drawing  

Construct detailed drawing of a lever safety valve
Objectives: At the end of this exercise you shall be able to
• draw the details of the lever safety valve
• draw hte full sectional front elevation
• draw the plan.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the given details of the lever safety valve with required elevations and plan by using CAD (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.7.118 
Draughtsman Mechanical - Machine shop layout 

Construct detailed drawing of a gate valve
Objectives: At the end of this exercise you shall be able to
• construct detailed drawing of a gate valve.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Construct detailed drawing of gate valve
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Capital Goods & Manufacturing  Exercise 2.7.119 
Draughtsman Mechanical - Detailed and assemble drawing  

Construct detailed drawing of a steam stop valve and blow of cock
Objectives: At the end of this exercise you shall be able to
• draw the steam stop valve detailed drawing by using CAD.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Construct detail drawing of steam stop valve using cad

i Draw the full plan view using CAD.

ii Prepare a bill of material.

Note: For assembling the steam stop valve refer 
the detail drawing indicate the parts as per the 
bill of material list in the views.
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Capital Goods & Manufacturing  Exercise 2.7.120 
Draughtsman Mechanical - Detailed and assemble drawing  

Hydraulics & pneumatics conventional signs and symbols
Objectives: At the end of this exercise you shall be able to 
• draw the hydraulic symbols used in mechanic drawing
• draw the pneumatic symbols used in mechanic drawing.  

i Draw the control valve symbols and its description. ii Draw the Pressure control valve symbols and it’s 
descriptions 

III Draw the Flow valve symbols and it’s description. 

IV	 Draw	the	Shut	–	off	valve	and	it’s	description

V Draw the Actuation’s mechanical components 
symbols and its descriptions.

Vi Draw the control methods symbols and its 
description. 

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Hydraulics connections and symbols (IS1219,1:1991)
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Hydraulic symbols  

vii Draw th cylinder symbols and its description.

Task 2: Pneumatics connections and symbols (IS,1219:1991)

i Draw the pneumatic circuits (IS,1219:1991) symbols 
and it’s description

ii Draw the Exhaust (PNEU) symbols and their 
descriptions.

iii	 Draw	 the	 power	 take	 off	 symbols	 and	 their	
descriptions

iv Draw the quick release coupling symbols and their 
description.

v Draw the servicing (PNEU) symbols and their 
descriptions.

vi Draw the air motor conventional symbols and their 
description.

Draw the conventional symbols to a suitable 
scale and print their descriptions.
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Pneumatic symbols
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Capital Goods & Manufacturing  Exercise 2.7.121 
Draughtsman Mechanical - Detailed and assemble drawing 

Draw sectional view of hydraulic jack and pneumatic valve actuator
Objectives: At the end of this exercise you shall be able to 
• draw hydraulic and pnematic valve actuator.  

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw orthographic view of hydraulic and pnematic valve actuator (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.7.122 
Draughtsman Mechanical - Detailed and assemble drawing  

Draw sectional view of a volute casing centrifugal pump
Objectives: At the end of this exercise you shall be able to 
• draw the sectional view of centrifugal pump.  

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the sectional view of centrifugal pump (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.7.123 
Draughtsman Mechanical - Detailed and assemble drawing 

Draw the detailed drawing of a lathe tool post
Objectives: At the end of this exercise you shall be able to 
• draw the detailed drawing of length tool post using AutoCAD.   

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the detailed drawing of lathe tool post using AutoCAD
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Capital Goods & Manufacturing  Exercise 2.7.124 
Draughtsman Mechanical - Detailed and assemble drawing  

Construct detailed drawing of tail stock
Objectives: At the end of this exercise you shall be able to 
• draw the detailed drawing of rain stock. 

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the detailed drawing of tail stock
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Capital Goods & Manufacturing  Exercise 2.7.125 
Draughtsman Mechanical - Detailed and assemble drawing  

Construct detailed drawing of a milling fixture
Objectives: At the end of this exercise you shall be able to 
• draw a detailed drawing of milling fixture.    

Milling fixture 
The three orthographic views of the Assembly of a 
Milling	fixture	production	drawing	are	shown	in	Fig.	The	

fixture	is	designed	to	cut	a	Slot	in	a	round	rod	of	15	mm	
diameter at its end as shown in the drawing. The slot  
is cut on a vertical milling Machine with a slitting saw 
cutter.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw a detailed drawing of milling fixture
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Capital Goods & Manufacturing  Exercise 2.7.126 
Draughtsman Mechanical - Detailed and assemble drawing  

Construct detailed assembly drawing of shaper tool head slide
Objectives: At the end of this exercise you shall be able to 
• draw detailed drawing of shaper tool head.  

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw detailed drawing of shaper tool head
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Capital Goods & Manufacturing  Exercise 2.7.127 
Draughtsman Mechanical - Detailed and assemble drawing  

Draw a simple drilling Jig for drilling holes
Objectives: At the end of this exercise you shall be able to 
• draw detailed drawing of dril jig.    

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw detailed drawing of drill jig

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



90 CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.7.127

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



91CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.7.127

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



92

Capital Goods & Manufacturing  Exercise 2.7.128 & 129 
Draughtsman Mechanical - Detailed and assemble drawing 

Draw the detailed drawing of a Press tools - dies - punches
Objectives: At the end of this exercise you shall be able to 
• draw the details of punch and die by using CAD 
• draw the Assembly view of the punch and dye by using CAD 
• draw the exploded view by using CAD
• prepare the bill of material.    

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the details of punch and dye by using CAD (Fig 1)
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• Draw all the details of the die and punch as given in 
the drawing

• In corporate all the dimensions in the detail drawing

• Indicate all the machinery symbols

• Add  the part list

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.7.128 & 129
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Capital Goods & Manufacturing  Exercise 2.7.130 
Draughtsman Mechanical - Detailed and assemble drawing  

Develop isometric drawing for injection mould with side cavities
Objectives: At the end of this exercise you shall be able to 
• draw the isometric view of the moulding ejected from injection mould 
• draw the cross-section view of the two plate mould.     

• Select suitable dimensions

TASK 2: Draw the sectional view and plan of the two plate mould (Fig 1)
• Select and draw with suitable dimensions.
• Replace the names in the views by numerical number

• Prepare a part list.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the pictorial view of the moulding ejected from injection mould (Fig 1)
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Capital Goods & Manufacturing  Exercise 2.7.131 
Draughtsman Mechanical - Detailed and assemble drawing  

Construct a detailed drawing of a simple carburettor
Objectives: At the end of this exercise you shall be able to 
• draw the given sectional front elevation view of the carburettor by using CAD  
• draw the side looking front right of the front elevation
• draw the plan view by using CAD.       

• Draw the side elevation looking from right of the front 
elevation by using CAD.

• Draw the full plan view by using CAD.

Note: Provide all the necessary dimensions 
and prepare title block.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the full sectional elevation of the carburettor by using CAD
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Capital Goods & Manufacturing  Exercise 2.7.132 
Draughtsman Mechanical - Detailed and assemble drawing 

Construct detailed drawing of a Pressure vessel
Objectives: At the end of this exercise you shall be able to 
• draw the detailed views of pressure vessel by using CAD
• draw the assembled views of pressure vessel by using CAD
• prepare part list.        

• Provide all dimensions and each detail.  • Provide part number for each detail as in assembled 
views.

TASK 2: Draw the following assembled views by using CAD

• Full sectional front elevation

• Side view looking from right of the sectional elevation

• Full plan

• Prepare bill of materials

Note: for assembly and side elevation refer 
the Assembly view.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the detailed views of the compress simple pressure vessel by using CAD 
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Capital Goods & Manufacturing  Exercise 2.7.133 
Draughtsman Mechanical - Detailed and assemble drawing 

Prepare detailed drawing of a ‘c’ clamp
Objectives: At the end of this exercise you shall be able to 
• draw detailed drawing of a ‘c’ clamp.       

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw detailed drawing of a ‘c’ clamp
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Capital Goods & Manufacturing  Exercise 2.7.134 
Draughtsman Mechanical - Detailed and assemble drawing  

Draw a simple machine shop layout of small industry
Objectives: At the end of this exercise you shall be able to 
• prepare a shop layout of a production.       
• design and placement of machines.  

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the shop layout with suitable dimension by using CAD (Fig 1)
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TASK 3: Draw the shop layout with suitable dimension using CAD (Fig 1)

TASK 2: Draw the shop layout with suitable dimension by using CAD. (Fig 1)

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.7.134

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



106

Capital Goods & Manufacturing  Exercise 2.8.135 
Draughtsman Mechanical - Solid works  

Draw 3D solid figure by sketching features and applied feature
Objectives: At the end of this exercise you shall be able to
• draw 3D solid figure by sketching feature.

Started, SOLIDWORKS Tools, Community, 3D 
Interconnect, Online Resources, Subscription 
Services and Tip of the Day options are displayed in 
this task pane.

2 Choose the New Document option from the Getting 
Started roll out of the SOLIDWORKS Resources task 
pane; the New SOLIDWORKS Document dialogue 
box is displayed, as shown in (Fig 3).

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Draw 3D solid figure by sketching feature (Figs 1&2)

Fig 1

Opening a new part Document 
1 Start SOLIDWORKS By double-clicking on the 

shortcut icon of SOLIDWORKS available on the 
desktop of your computer; the SOLIDWORKS 2017 
window along with the SOLIDWORKS Resources 
task pane on its right is displayed. The Getting 

Fig 3

3 In the New SOLIDWORKS Document dialogue box, 
the Part button is chosen by default. Therefore, 
choose the OK button; a new SOLIDWORKS part 
document starts. 

4 Choose the Sketch tab from the Command Manager 
and then the Sketch button in the Sketch Command 
Manager; the Edit Sketch Property Manager is 
displayed and you are promoted to select a plane on 
which you want to draw the sketch.

5 Select the Front Plane from the drawing area; the 
sketching environment is invoked and the plane 
gets oriented normal to the view. You will notice that 
red coloured arrows are displayed at the centre of 
the screen, indicating that you are in the sketching 
environment. Also, the confirmation corner with 
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the Exist Sketch and Cancel options is displayed 
on the upper right corner in the graphics area. The 

screen display in the sketching environment of 
SOLIDWORKS 2017 is shown in (Fig 4).

1 Choose the Options button from the Menu Bar: the 
System Options - General dialogue box is displayed.

2 Choose the Document Properties tab; the name 
of the dialogue box changes to the Document 
Properties - Drafting Standard.

3 Select the Units option from the area on the left to 
display the options related to the linear and angular 
units.

4 Select the MMGS (millimetre, gram, second) radio 
button in the Unit System area. Also, select the 
Degree option in the Units column as unit of angle, if 
it is not selected by default. You can also change the 
unit system using the Unit System button, which is 
located at the right side of the status bar.

5 Select the Grid/ Snap option from the area on the 
left to display grid options  set the value in the Major 
grid spacing spinner to 50 and the value in the Minor 
lines per major spinner to 10.

6 Select the Display grid check box if it is cleared. Next 
choose the Go To System Snaps button the system 
options related to relations and snaps are displayed.

7 Select the GRID check box from the Sketch Snaps 
area and clear the Snap only when grid is displayed 
check box. Choose OK to exit the dialogue box.

Drawing the Sketch
It is evident from figure that the sketch will be drawn 
using the Line tool. Therefore you need to start drawing 
the sketch from the lower left corner of the sketch.
1 Choose the Line tool from the Sketch Command 

Manager the arrow cursor is replaced by the line 
cursor.

2 Move the Line cursor to the origin.
3 Left click at this point and move the cursor 

Horizontally toward the right. You will notice that the 

Fig 4

Screen display in the sketching environment.

symbol of the Horizontal relation is displayed below 
the line cursor and the length and angle of the line 
are displayed above the line cursor.

4 Left click again when the length of the line above the 
line cursor shows 20.

The first horizontal line is drawn. As your drawing 
continuous lines the end point of the line drawn is 
automatically selected as the the start point of the next 
line.

5 Move the line cursor vertically upward. The symbol 
of the Vertical relation is displayed on the right of 
the line cursor and the length of the line is displayed 
above  the line cursor. Click when the length of the 
line on the line curs or is displayed as 20.

6 Move the cursor horizontally toward the left and 
click when the length of the line on the line cursor is 
displayed as 5.

7 Move the Line cursor vertically upward and press the 
left mouse button when the length of the line on the 
line cursor is displayed as 25.

8 Move the line cursor Horizontally towards the right 
and click when the length of the line on the line 
cursor is displayed as 20.

9 Move the line cursor vertically upward and click when 
the length of the line on the line cursor is displayed 
as 5.

10 press F on the keyboard to fit the sketch on the 
screen.

11 Move the line cursor Horizontally toward the left and 
click when the length of the line on the line cursor is 
displayed as 50.

12 Move the line cursor ventrically downward and click 
when the length of the line on the line cursor is 
displayed as 5.
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13 Move the line cursor Horizontally toward the right 
and press the left mouse button when the length of 
the line on the line cursor is displayed as 20.

14 Move the Line cursor vertically downward and click 
when the length of the line on the line cursor is 
displayed as 25.

15 Move the line cursor Horizontally toward the left and 
click when the length of the line on the line cursor is 
displayed as 5.

16 Move the  line cursor vertically downward to the start 
point of the first line. Click when an orange circle is 
displayed. The final sketch for Tutorial 1 is created 
as shown in figure. In this figure  grid display and 
Shaded Sketch Contours settings or turned off for 
clarity.

17 Right click and then choose the Select option from 
the shortcut menu to exit the Line tool. (Fig 5)

3 Adding Dimensions:

• Add dimensions to define the size of the angle plate.

• Use Smart Dimension to specify the lengths and the 
angles of the lines.

4 Applying constraints

• Use geometric constraints like coincident and 
parallel to align lines and corners as needed.

• Apply dimensions to fully define the shape.

5 Extruding the sketch:

• Exit the sketch mode and go to the “Features” tab in 
the Command Manager.

• Click on “Extruded Boss/Base” and select the sketch 
profile.

• Specify the extrusion distance to create the 3D angle 
plate.

Creating a Block:
1 Sketching the block

• Follow similar step us above to create a new sketch 
on a plane (e.g. Top plane)

• Use the rectangle tool to draw the outline of the 
block.

2 Adding dimensions:

• Add dimensions to define the length width and height 
of the block.

3 Applying constraints:

• Use constraints like horizontal and vertical to align 
edges of the rectangle.

• Apply dimensions to fully define the block is size.

4 Extruding the sketch :

• Exit the sketch mode and go to the “Features” tab.

• Click on “Extruded Boss/Base” and select the sketch 
profile.

• Specify the extrusion death to create a 3D block

Modifying constraints:
After you have created the angle plate and block, you 
can modify constraints to change their positions.

1 Editing the Sketch

• Double click on the sketch in the Future Manager 
Design Tree to edit it.

2 Modifying Dimensions and Constraints.

• Change the values of dimensions to adjust the size 
and angles of the sketch elements.

• You can also add to remove geometric constraints to 
achieve the desired changes.

3 Updating the model:

•  After editing the sketch, exiting the sketch mode.

Fig 5

Final sketch for Tutorial 1

1 Choose the Save button from the Menu Bar to invoke 
the Save As dialogue box. Create the SOLIDWORKS 
folder inside the Documents folder and then create 
the c02 folder inside the SOLIDWORKS folder.

2 Enter c02_tut01 as the name of the document in 
the File name edit box and choose the Save button. 
The document is saved at the location \Documents \
SOLID WORKS\c02

3 Close the document by choosing File > Close from 
the SOLIDWORKS menus.

Sketch an  angle plate and a block modify 
constraints:
Create an Angle plate:
1 Open Solid Works: Launch Solid Works and create a 

new part document.

2 Sketching the angle plate.

• Click on the “Sketch” tab in the Command manager.

• Choose a plane (e.g. Front Plane) to sketch on.

• Use the Line,  Rectangle and Dimensions tools to 
create the outline of the angle plate
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Capital Goods & Manufacturing  Exercise 2.8.136 
Draughtsman Mechanical - Solid works 

Sketch an angle plate and a block
Objectives: At the end of this exercise you shall be able to
• sketch an angle block.

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Sketch an angle block (Figs 1 - 9)

Fig 1

Fig 2
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Fig 3

Fig 4

Fig 5
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Fig 6

Fig 7

Fig 8
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Fig 9
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Capital Goods & Manufacturing  Exercise 2.8.137 
Draughtsman Mechanical - Solid works  

Create a Sketch of a new part
Objectives: At the end of this exercise you shall be able to
• create a Sketch of a part.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Create a Sketch of a part
The following steps are required to complete this tutorial:  

a Start a new part document.

b Invoke the sketching environment.

c Create a centre line.

Fig 1

d Draw and edit the sketch using the Mirror Entities and 
Trim Entities tools.

e Offset the entire sketch.

f Complete the final editing of the sketch using the 
Extend Entities and Trim Entities tools. (Fig 1)

Starting a New Document
1 Choose the New button from the Menu Bar to invoke 

the New SOLIDWORKS Document dialog box. 

2 The Part button is chosen by default in the New 
SOLIDWORKS Document dialog box. Choose the 
OK button. 

3 Choose the Sketch button from the Sketch Command 
Manager and select Front Plane to invoke the sketch-
ing environment.

4 Invoke the Document Properties – Units dialog box 
and change the units to MMGS (millimetre, gram, 
second) if it is not selected by default.

5 Invoke the Document Properties – Grid/Snap dialog 
box. Now, set 100 in the Major grid spacing spinner 
and 10 in the Minor-lines per major spinner. Choose 
the OK button.

Drawing the Centre line

Before drawing the sketch, you need to draw a centre 
line that will act as reference for other sketched entities. 
This centreline will also be used for mirroring.

1 Choose the Centre line button  from the Line flyout in 
the Sketch Command Manager.

2 Move the cursor to a location whose coordinates are 
– 70 mm, 0 mm, and 0 mm.
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3 Specify this point as the start point and move the 
cursor horizontally toward the right.

4 Specify the end point of the centreline by clicking at a 
location when the value of the length of the centreline 
above the line cursor is 140.

5 Double-click anywhere in the drawing area to end the 
line creation and exit the Centre line tool.

Drawing the Outer Loop of the Sketch
Next, you need to draw the outer loop of the sketch using 
the sketch tools. As it is evident from (Fig 2), the sketch 
needs to be drawn using the Circle and Line tools.
1 Press and hold the right-mouse button and drag the 

cursor to the right, the mouse gesture is displayed 
with sketching tools. Move the cursor over the Circle 
tool, the Circle tool is invoked and the Circle Property 
Manger is displayed.

2 Make  sure that the Circle button is chosen in the Circle 
Type roll out in the Circle Property Manger. Move the 
circle cursor to the origin and click when an orange 
circle is displayed to specify the centre point of the 
circle.

3 Move the cursor horizontally toward the right and draw 
a circle of 100 mm diameter.

4 Choose the Zoom to fit button from the View (Heads-
Up) tool bar to increase the display of the sketch.

5 Choose the Line button from the Sketch Command 
Manger and move the cursor to a location whose 
coordinates are 60 mm, 10 mm, and 0 mm. Specify 
the start point of the line at this location.

6 Move the cursor horizontally toward the right and 
click to specify the end point of the line when the line 
cursor snaps the circle. Exit the Line tool.

7 Press the hold the SHIFT key and then using the left 
mouse button, select the centre line, and the horizontal 
line created in the last step.

Fig 2

8 Choose the Mirror Entities button from the Sketch 
Command Manager, the mirror image of the horizontal 
line is created on the other side of the centre line.

Fig 3

9 Choose the Line button using the mouse gesture, refer 
to (Fig 3) and then move the cursor to the left end point 
of the upper horizontal line. Click to specify the start 
point of the line when the orange circle is displayed.

10 Move the cursor vertically downward. Click in the 
drawing area when the cursor snaps to the left end 
point of the lower horizontal line. Exit the Line tool.

11 Choose the Trim Entities button from the Sketch  
Command Manger, the Trim Property Manager is 
displayed.

12 Choose the Power trim button from the Property  
Manger. Press and hold the left mouse button and drag 
the cursor over the portion to be removed. Choose 
the Close Dialog button from the Property Manager. 
The sketch after removing the unwanted portion is 
shown in Figure.

Offsetting the Entities
After drawing the outer loop of the sketch, you need to 
draw to the inner loop. The first step for drawing the inner 
loop of the sketch is offsetting the entire sketch inward.
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1 Choose the Offset Entities button from the Sketch 
Command Manager,  the Offset Entities Property 
Manager is displayed on the left in the drawing area.

2 Set the value of the Offset Distance spinner to 4. 
Select the Add dimensions and Select chain check 
boxes, if they are not selected. Select any one entity 
of the sketch; the entire sketch is selected.

When you select the sketch, the preview of the offset 
sketch is displayed in the drawing area. The direction of 
the offset is outward. However, the direction of the offset 
should be inward of the sketch. Therefore, you need to 
flip the direction.

3 Move the cursor inside the sketch and press the left 
mouse button to offset the sketch inside the original 
sketch; a dimension with the value 4 is displayed with 
the sketch.

The sketch after offsetting the outer loop is shown in Figure.

Fig 4

(Fig 4) The sketch after removing the unwanted portion

Fig 5

(Fig 5) Sketch after offsetting the outer loop

Extending and Trimming the Entities
1 Choose the Extend Entities button from the Trim 

Entities flyout in the Sketch Command Manager, the 
select cursor is replaced by the extend cursor.

2 Move the cursor close to the left end of the lower 
horizontal line of the inner loop. You can preview the 
extended line appearing in orange.

You need to move the cursor a little toward the left  if the 
preview of the extended line appears on the right.

3 Press the left mouse button to extend the line.

4 Similarly, extend the upper horizontal line of the inner 
sketch. The sketch after extending the lines is shown 
in (Fig 6).

5 Right-click and choose the  Trim Entities option from 
the shortcut menu; the extend cursor is replaced by 
t he trim cursor.

6 Trim the unwanted entities as discussed earlier and 
exit the t rim command. The final sketch is shown in 
(Fig 7).

Fig 6

Sketch after extending the lines

Fig 7

(Fig 7) Final sketch for Tutorial 2

Saving the Sketch
1 Choose t he Save button from the Menu Bar to invoke 

the Save As dialog box.

2 Enter c03_tut02 as the name of the document in the 
Film name edit box and then choose the Save button.

3 Close the file by choosing File>Close from the 
SOLIDWORKS menus.
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Capital Goods & Manufacturing  Exercise 2.8.138 
Draughtsman Mechanical - Solid works  

Create 3D Solid and Edit using copy Loop, File time, C hampering, Editing, 
Create rib, mirror, Hole wizard, create part confirmation
Objectives: At the end of this exercise you shall be able to
• draw 3D solid and edit using modify features.

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Draw 3D solid and edit using modify features (Figs 1 - 3) 

Fig 2 Fig 3
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The following steps are required to complete this 
tutorial:
a Create the base feature of the model by revolving the 

sketch along the centre line.

b Create the second feature by extruding the sketch 
from the sketch plane to the selected surface.

c Place a counter bore hole feature on the bottom face 
of the second feature using the Hole Wizard tool.

d Pattern the second and third features along the  
temporary axis using the Circular Pattern tool.

e Create the rib feature.

f Pattern the rib feature along a temporary axis using 
the Circular Pattern tool.

Creating the Base Feature
Start a new SOLIDWORKS part  document. First, 
you need to create the base feature of the model by  
revolving the sketch along the axis of revolution. The axis 
of revolution will be a centre line and the sketch for the 
base feature will be drawn on the Right Plane.

1 Invoke the Revolved Boss/Base tool and select the 
Right Plane as the sketching plane.

2 Create the Sketch for the base feature and add the 
required relations and dimensions to the sketch, as 
shown in (Fig 4)

3 Exit the sketching environment and set the value in 
the Direction 1 Angle spinner as 360

4 Choose the OK button from the Revolve Property 
Manager, the base feature is created, as shown in 
(Fig 5).

Creating the Second Feature
The second feature needs to be created by extruding the 
sketch up to the selected surface.

1 Invoke the Extruded Boss/Base tool and select the 
face as the sketching plane, as shown in (Fig 6).

2 Create the sketch of the second feature and add the 
required relations and dimensions to it, as shown in 
(Fig 7)

Fig 5

Fig 6

Fig 7

3 Exit the sketching environment. Use the Up To  
Surface option to extrude the sketch. The surface to 
be selected is shown in (Fig 8).

4 Choose the OK button from the Boss-Extrude Property 
Manager, the second feature is created, as shown in 
(Fig 9).

Creating the Hole Feature
It is evident from (Fig 1) that a counter bore hole needs 
to be added to the model. It can be added by using the 
Hole Wizard tool.

1 Select the bottom face of the second feature as the 
placement plane for the hole feature and press the S 
key; the Shortcut toolbar is displayed.

2 Choose Hole Wizard from the Shortcut toolbar to 
invoke the Hole Specification Property Manager.
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edge of the second feature. Choose the OK button 
to exit the Add Relations Property Manager.

8 Now, choose the OK button from the Hole Position 
Property Manager to end the feature creation.

Patterning the Features
After creating the second and third features, you need to 
pattern them using the Circular Pattern tool.

1 Choose the Circular Pattern button from the Linear 
Pattern flyout; the Cir Pattern Property Manager is 
invoked.

2 Select the second and third features from the drawing 
area or from the Feature Manager Design Tree that 
is displayed in the drawing area.

3 Click on the Pattern Axis selection box in the  
CirPattern Property Manager and select the circular 
edge of the base feature; preview of the circular  
pattern of the hole feature is displayed.

4 Set the value in the Number of Instances spinner 
to 3 and make sure the Equal spacing check box is 
selected. Clear the Geometry pattern check box from 
the Options roll out, if it is selected.

5 Choose the OK button from the Cir Pattern Property 
Manager, the features are patterned, as shown in  
(Fig 10).

Fig 8

Fig 9

3 Choose the Counter bore button from the Hole Type 
roll out, if it is not chosen by default, and select the 
ANSI Metric option from the Standard drop-down list.

4 Select the Socket Button Head Cap Screw – ANSI 
B18.3.4M option from the Type drop-down list. Select 
the M3 option from the Size drop-down list. Select 
Through All in the End Condition drop-down list in the 
End Condition roll out.

5 Select the Show custom sizing check box to  
customize the size of the counter bore hole and then 
enter the following parameters:

Through Hole Diameter: 3.6 mm

counter bore Diameter: 6.70 mm

counter bore Depth: 1.65 mm

6 Choose the Positions tab from the Hole Specifica-
tion Property Manager, you are prompted to use  
dimensions and other sketching tools to position the 
centre of the holes.

7 Specify the position of the hole and then choose 
the Add Relation button from the Sketch Command 
Manager, the Add Relations Property Manager will be 
invoked. Now apply the concentric relation between 
the centre point of the hole feature and the circular 

Fig 10

Creating the Rib Feature
The next feature is a rib feature. The sketch for the rib 
feature will be created on the Front Plane.

1 Choose the Rib button from the Features Command 
Manager and select the Front Plane from the Feature 
Manager Design Tree; the sketch environment will be 
invoked.

2 Set the display mode to wire frame and then create 
the sketch for the rib feature and add the required 
relations, as shown in (Fig 11).

3 Exit the sketching environment and set the value of 
the Rib Thickness spinner to 2. Reverse the direction 
of material, if required, using the Flip material side 
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check box. Use the default values for other options 
and choose the OK button from the Rib Property 
Manager.

4 Change the display mode of the model to shaded with 
edges.

5 Use the Circular Pattern tool to create six instances 
of the rib feature. The final model after creating all the 
features is shown in (Fig 12).

Saving the Model
1 Save the model with name c08_tut02 at the location 

given  below: \Documents\SOLIDWORKS\c08

2 Choose File > Close from the SOLIDWORKS menus 
to close the document.

Fig 11

Fig 12
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Capital Goods & Manufacturing  Exercise 2.8.139 
Draughtsman Mechanical - Solid works 

Create New Assembly Part
Objectives: At the end of this exercise you shall be able to
• create a new assembly.

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Create a new assembly

Fig 1 You will create all components of the Pipe Vice assembly 
as separate part documents. After creating the parts, 
you will assemble them in the assembly document. In 
this tutorial, you need to use the bottom-up approach for 
creating the assembly. (Figs 1&2) 

The following steps are required to complete this 
tutorial:
a Create all the components as separate part documents 

and then save them. The part documents will be saved 
at \Documents\SOLIDWORKS\c12\Pipe Vice.

b Place the Base at the origin of the assembly.

c Place the Moveable Jaw and the Screw in the  
assembly. Apply mates between the Moveable Jaw 
and the Screw.© N
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d Assemble the Screw with the Base. e Place other components in the Assembly and apply 
mates to the assembly

Creating Components
1 Create all the components of the Pipe Vice assembly 

as separate part documents. Specify the names of the 
files, as shown in (Fig 3). Save the documents at the 
location \Documents\SOLIDWORKS\c12\Pipe Vice.

Inserting the First Component into the Assembly
After creating all the components of the Pipe Vice  
assembly, you need to start a new SOLIDWORKS as-
sembly document.
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1 Start a new SOLIDWORKS assembly document; the 
Begin Assembly Property Manager is displayed by 
default. (Fig 4)

2 Choose the Browse button from the Part/Assembly to 
Insert roll out to display the Open dialog box. Open 
the Pipe Vice folder and double-click on the Base.

3 Choose the OK button from the Begin Assembly  
Property Manager to place the Base part origin coin-
cident at the origin of the assembly document.

4 Change the view orientation to isometric.

Inserting and Assembling the Moveable Jaw and 
the Screw 
After placing the first component in the assembly  
document, you need to place the Moveable Jaw and the 
Screw in the assembly document. After placing these 
components, you need to apply the required mates.

1 Choose the Insert Components button from the  
Assembly Command Manager. Then, choose the 
Keep Visible button from the Property Manager to 
keep it visible. Next, invoke the Open dialog box by 
choosing the Browse button from the Part/Assembly 
to Insert rollout.

2 Double-click on the Movable Jaw. Place the  
component anywhere in the assembly document such 
that it does not interface with the existing component.

3 Similarly, place the Screw in the assembly document 
and choose the OK button from the Insert Component 
Property Manager. (Fig 5) shows the Moveable Jaw, 
Screw, and Base placed in the assembly document.

First you need to assemble the Screw with the Moveable 
Jaw. Therefore, you need to fix the Moveable Jaw.
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Fig 5

Fig 6

4 Select the Moveable Jaw from the drawing area or 
from the Feature Manager Design Tree. Right-click 
to invoke the shortcut menu.

5 Choose the Fix option from the shortcut menu; the 
Moveable Jaw becomes fixed and you cannot move 
or rotate it.

6 Invoke the Move Component Property Manager and 
choose the Smart Mates button from the Move roll 
out. Double-click on the lower most cylindrical face 
of the Screw; the Screw appears transparent.

7 Drag the cursor to the hole located at the top of the 
Moveable Jaw. Release the left mouse button as 
soon as the concentric symbol is displayed below the 
cursor. Next, choose the Add/Finish Mate button from 
the Mate pop-up toolbar.

8 Select the Screw and move it up so that it is  not inside 
the Moveable Jaw.

9 Right-click in the drawing area and then choose Clear 
Selections from the shortcut menu to clear the current 
selection.

10 Rotate at the assembly and double-click on the lower 
flat face of the Screw; the Screw appears transparent.

11 Rotate the model again and select the top planar face 
of the Movable Jaw. The coincident mate is applied 
between the two selected faces. Choose the Add/
Finish Mate button from the Mate pop-up toolbar.

12 Choose the OK button from the Smart Mates  
Property Manager. (Fig 6) shows the Screw after 
applying mates.

Next, you need to assemble the Screw and the Moveable 
Jaw with the Base.
13 Select the Moveable Jaw and right click on it; a shortcut 

menu will be displayed. Choose the Float option from 
this shortcut menu. Now, you can move the Moveable 
Jaw and the Screw assembled to it.

14 Press the ALT key, select the cylindrical face of the 
screw and move the screw toward the hole created on 
the top face of the Base to add the concentric mate.

15 Invoke the Mate Property Manager and then select 
the front planar face of the Moveable Jaw and the 
front planar face of the Base.

16 Choose the Parallel button from the Mate pop-up 
toolbar and then choose the Add/Finish Mate button 
to add the Parallel mate between the selected faces.

17 Next, select the faces, as shown in (Fig 7).

18 Expand the Advanced Mates roll out and then choose 
the Distance button from it; the Maximum Value and 
Minimum Value edit boxes become available.

19 Enter 65 and 5 in the Maximum Value and Minimum 
Value edit boxes respectively. Next, choose OK from 
the Mate Property Manager.

You will learn more about the advanced mates in the 
next chapter.
20 Similarly, assemble the other components of the 

Pipe Vice assembly. (Fig 8) shows the final Pipe Vice  
assembly.

21 Choose the Save button to save the assembly  
document at the location \Documents\SOLIDWORKS\
c12\Pipe Vice.

Fig 7

Fig 8
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Capital Goods & Manufacturing  Exercise 2.8.140 
Draughtsman Mechanical - Solid works  

Create a 3D Model
Objectives: At the end of this exercise you shall be able to
• create a 3D Model 2 Bill of material.

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Create a 3D Model 2 Bill of material (Fig 1) 

a Copy the Bench Vice folder, which contains parts, 
assembly, and the drawing document, from Chapter 
14 to the folder of the current chapter. 

b Delete the views that are not required in the drawing 
sheet.

c Move the views and arrange them in the drawing 
sheet.

d Set  the anchor on the drawing sheet where the BOM 
will be attached.

e Generate the BOM.

f Add balloons to the isometric view.

Copying the Bench Vice Assembly Folder to the 
Current Folder
Before proceeding, you need to copy the model and the 
drawing document in the folder of the current chapter.
1 Copy the Bench Vice folder from the \Documents\

SOLIDWORKS\c14 folder to the folder of the current 
chapter.

Opening the Drawing Document
After copying the folder, you need to open the drawing 
document in the SOLIDWORKS window.

The drawing document in which you need to generate 
the BOM and balloons is displayed in Figure.
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Deleting the Unwanted View
You need to delete the right view because it is not required 
in this tutorial.
1 Select the right-side view and press the DELETE key; 

the Confirm Delete dialog box is displayed.
2 Choose the Yes button from this dialog box; the view 

is deleted from the current drawing sheet.
Moving the Isometric View
You need to move the exploded isometric view because 
the BOM will be generated and placed at the top right 
corner of the drawing sheet.
1 Select the isometric view; the border of the view is 

highlighted.
2 Move the cursor to  the border; the cursor is replaced 

by the move cursor.
3 Select the border and drag the cursor to move the 

drawing view and then place it at the required location.
Setting the Anchor for the BOM
Before generating the BOM, you need to set its anchor. 
The anchor is a point on the drawing sheet to which one of 
the corners of the BOM coincides. By default, the anchor 
is defined at the top left corner of the drawing sheet. But 
in this tutorial, you need to add the BOM at the top right 
corner of the drawing sheet. Therefore, you need to set 
the anchor before generating the BOM.
1 Expand Sheet 1 from the Feature Manager Design 

Tree and then expand Sheet Format 1.
2 Select the Bill of Materials Anchor 1 option, right-click 

on it to invoke a shortcut menu and then choose the 
Set Anchor option from it; the drawing views disappear 
from the sheet.

3 Specify the anchor point on the inner top right corner 
of the drawing sheet; a point is placed at the selected 
location.

After you specify the anchor point, the drawing views are 
displayed automatically in the sheet because the sheet 
editing environment is invoked automatically.
Generating the BOM
Next, you need to generate the BOM. As discussed earlier, 
the BOM generated in SOLIDWORKS  is parametric. 
If a component is deleted or added in the assembly, the  
change is reflected automatically in the BOM. But before 
generating the BOM, you need to set its text parameters.

1 Invoke the System Options – General dialog box by 
choosing the Options button from the Menu Bar.

2 Next, choose the Document Properties tab in the 
System Options – General dialog box to invoke the 
Document Properties – Drafting Standard dialog box 
and then choose Annotations > Notes from the area 
on the left.

3 Choose the Font button from the Test area of the dialog 
box; the Choose Font dialog box is invoked. Select 
the Points radio button from the Height area and set 

the value of the font size to 9 from the list box.

4 Choose the OK button from the Choose Font dialog 
box. Similarly, change the text height of balloons to 
14 and close the dialog box.

5 Select the isometric view and choose Tables > Bill of 
Materials from the Annotation Command Manger, the 
Bill of Materials Property Manager is displayed.

6 Select the Attach to anchor point check box in the 
Table Position roll out.

7 Choose the OK button from the Bill of Materials  
Property Manager, the BOM is generated. If the BOM 
is displayed outside the drawing sheet, move the  
cursor over the BOM; an anchor symbol is displayed. 
Click  on the symbol; the Bill of Materials Property 
Manager is displayed. Select an appropriate position 
for placing the BOM from the Table Position roll out 
and then choose the Close Dialog button; you will 
notice that the Description column is also displayed 
in the BOM. But this column is not required, so you 
need to delete it.

8 Move the cursor over the Description heading and 
right-click to display a shortcut menu. Choose De-
lete > Column from the shortcut menu; the column is  
deleted. The drawing sheet after generating the BOM 
and deleting the Description column is displayed.

Adding Balloons to the Components
After generating the BOM, you need to add balloons 
to the components. Before proceeding, make sure that 
you have changed the font height of balloons to 14, as 
discussed in the previous section.

1 Select the isometric view and choose the Auto Balloon 
button from the Annotation Command Manager, the 
balloons are automatically added to all the components 
in the isometric view and the Auto Balloon Property 
Manager is also displayed.

The multiple instances of any component are ignored 
because the Ignore multiple instances check box is  
already selected in the Balloon Layout roll out. Also, make 
sure that the Insert magnetic line(s) check box is cleared.

2 Select 1 Character from the Size drop-down list in the 
Balloon Settings roll out. Next, choose OK to close 
this Property Manager.

The balloons are added to all the components. You will 
notice that the balloons are not properly arranged on the 
sheet and are placed arbitrarily. Therefore, you need to 
drag each balloon manually to place it properly.

3 Move the cursor over any one of the balloons and 
when it is highlighted, drag it to place it at another 
location.

4 Similarly, drag and place the remaining balloons at 
proper locations. The final drawing sheet after adding 
and rearranging balloons.
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Capital Goods & Manufacturing  Exercise 2.8.141 
Draughtsman Mechanical - Solid works  

Prepare drawing & detailing
Objectives: At the end of this exercise you shall be able to
• create drawing sheets.

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Create drawing Sheets  

The following steps are required to complete this tutorial:  
a Copy the part document of Tutorial 2 of Chapter 8 in 

the folder of the current chapter.
b Open the copied part document and start a new draw-

ing document from within the part document.
c Select the standard A4 landscape sheet format and 

generate the parent view.
d Generate projected views using the Projected View 

tool.
e Generate the aligned section view using the Section 

View tool.
f Generate the detail view.
g Save and close the drawing document.
Copying and Opening the Part Document
1 Create a folder with the name c14 in the SOLIDWORKS 

directory and copy c08_tut02.sldprt from the location\
Documents\SOLIDWORKS\c08.

2 Start SOLIDWORKS and open the part document that 
you copied in the c14 folder.

Starting a New Drawing Document
As mentioned earlier in this chapter, you can start a new 
drawing document from the part document. This way, the 
model in the part document is automatically selected and 
you can generate its drawing views.
1 Choose New > Make Drawing from Part/Assembly 

from the Menu Bar; the Sheet Format/Size dialog box 
is displayed.

2  Clear the only show standard formats check box and 
select the A4 (ANSI) landscape sheet from the list 
box in this dialog box and choose the ok button, a 
new drawing document is started with the standard 
A4 sheet and the view palette task pane is displayed 
automatically.

Generating the Parent View and the Projected Views
Before you proceed to generate the drawing views, you 
need to confirm, whether the projection type for the cur-
rent sheet is set to the third angle.

1 Click anywhere on the sheet to close the View Paletee 
task pane. Select Sheet 1 from the Feature Manager 
Design Tree and then right-click to display shortcut 
menu. Choose the Properties option from the shortcut 
menu; the Sheet Properties dialog box is displayed.

2 Select the Third angle radio button from the Type of 
projection area if not selected by default and then 
choose the Apply Changes button.

3 Choose the View Palette tab to view the View Palette 
task pane and make sure the Auto-Start Projected 
View check box is selected.

4 Selected the Front view from the View Palette task 
pane and drag it to the middle left of the drawing sheet 
above the title block. Drop the view at this location to 
place the front view, refer  to (Fig 1). The Projected 
View Property Manager is invoked automatically and 
preview of the projected view is attached to the cursor.

5 Next, move the cursor vertically upward from the front 
view; a preview of the top view is displayed. Specify 
a point to place the top view, refer to (Fig 1). Preview 
of another projected view with the front view as the 
parent view is attached to the cursor.

6 Next, move the cursor horizontally toward right from 
the front view, a preview of the side view is displayed. 
Specify a point to place the side view, refer to (Fig 1).

7 Move the cursor horizontally toward the right and then 
move it upward; a preview of the isometric view is 
displayed. Specify a point to place the isometric view. 
Next, choose the OK button in the Property Manager.

The current location of the isometric view of the model 
is such that it will interfere with the aligned section view 
that you need to place next. Therefore, you need to 
move the isometric view close to the top right corner of 
the drawing sheet.
8 Move the cursor over the isometric view; the bounding 

box of the view is displayed in orange.
9 Click  to select the view; the border of the view is 

highlighted.
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Fig 1

10 Move the cursor on one of the border lines of the view; 
the cursor changes into a move cursor.

11 Press and hold the left mouse button and drag the view 
close to the upper right corner of the drawing sheet. 
The drawing sheet after generating and moving the 
isometric view is shown in (Fig 1).

The center marks are automatically created in the drawing 
views of the circular features in a model.
Generating the Aligned Section View
1 Click on the top view to activate it.
2 Invoke the Design Command Manager and choose the 

Section View button; the Section View Assist Property 
Manager is displayed.

3 Choose the Aligned button in the Cutting Line rollout 
and create the cutting plane line, as shown in the Sec-
tion View pop-up toolbar is displayed. Choose the OK 
button from the pop-up toolbar; the SOLIDWORKS  
information box is displayed with the message that 
the selected model has a rib feature that will vary the 
hatching of the section view. It also asks you whether 
to make an aligned section view or a foreshortened 
section view.

4 Choose the Make aligned section view option from the 
SOLIDWORKS information box; the aligned section 
view is attached to the cursor.

The view generated is normal to the vertical line. If the 
direction of viewing the aligned section view is in opposite 
direction, you need to flip it after placing the view.
5 Move the cursor to the right of the top view and place 

the aligned section view; the Section View Property 
Manger is displayed. If the direction of viewing is not 
the required one, select the Flip Direction button. Click 
anywhere on the sheet to exit the Property Manager.

The sheet after generating the aligned section view is 
shown in (Fig 2).
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Capital Goods & Manufacturing  Exercise 2.8.142 
Draughtsman Mechanical - Solid works  

Create a 3D transition figure: Create 3D model by annotating holes and threads, 
create centre lines, symbols and leaders, create simulation, plot the model
Objectives: At the end of this exercise you shall be able to
• create a 3D transition figure.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Create a 3D transition figure 
1 Create a 3D Model with Annotations, Holes and 

Threads:  

• Create a new part documents.

• Use sketch tools to create the base profile for your 
transition figure.

• Add holes and threads using the “Hole Wizard” 
and “Thread” features from the “Features” tab.

• For annotations, use the “Annotations” tab to add 
dimensions to define the geometry.

2 Create Centre Lines, Symbols, and Leaders:

•  Use the “Centre line” tool in the “Annotations” tab 
to create centre lines that represent symmetry or  
reference axes.

• Insert symbols (e.g. surface finish symbols) using 
the “Symbols” tool from the Annotation” tab.

• Add leaders to annotations using the “Leader” tool 
to connect notes or symbols to specific locations.

3 Create Simulation:

• Go to the “Simulation” tab (if available in your 
SOLIDWORKS version) or use SOLIDWORKS 
Simulation.

• Define the material properties, loads, restraints 
and other simulation parameters.

• Run the simulation to analyze stress, deformation, 
and other mechanical behaviour.

4 Plot the Model:

• Create a new drawing document.

• Insert the 3D model view by using the “Model View” 
tool and selecting the 3D model from the part.

• Use the “Annotations” tab to add dimensions, centre 
lines, symbols and leaders in the drawing view.

• You can also add notes and other information to 
explain the design or simulation results.

• Set up the drawing sheet with title blocks, and any 
required information.

• If you’re plotting to paper or a PDF, use the “File” 
menu to print or save the drawing as a PDF.
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Capital Goods & Manufacturing  Exercise 2.8.143 
Draughtsman Mechanical - Solid works 

Convert or save as solid works file into drawing format
Objectives: At the end of this exercise you shall be able to
• convert solid work into drawing format.

Requirements

Tools/Equipment/Machines

• Solid works 2017 or Higher version.

PROCEDURE

TASK 1: Convert Solid work into drawing format    

1 Open or Create the Drawing:  

• Open the part or assembly file you want to create 
a drawing for.

• Go to “File” > “New” > “Drawing” to create a new 
drawing file.

2 Add Model Views:

• In the drawing, use the “Model View” tool to insert 
the 3D Model.

• Choose the desired orientation and scale for the 
model view.

3 Add Annotations and Details:

• Use the “Annotations” tab to add dimensions, centre 
lines, symbols and other annotations to the model 
view.

• Add title blocks, borders, and other necessary  
information to the drawing sheet.

4 Save the Drawing:

• Once you’ve added all the necessary views and 
annotations, go to “File” > “Save As”.

• Choose a location to save the drawing and give it 
a name.

• Select the appropriate file type for the drawing. The 
most common format is “SOLIDWORKS” Drawing 
(*.slddrw).”

5 Optional: Export to Other Formats:

• If you need to share the drawing with others who 
don’t have SOLIDWORKS, you can also export it 
to different file formats such as PDF, DXF, or DWG.

• Go to “File” > “Save As” and choose the desired 
file format from the drop/down list.
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Capital Goods & Manufacturing  Exercise 2.9.144 
Draughtsman Mechanical - Production drawing 

Construct detailed and Assembly drawing 
Objectives: At the end of this exercise you shall be able to
• draw the details of the drilling jigs
• draw the full plan
• draw the full sectional elevation of the assembled view.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw the assembly drawing of the drilling using the details by using CAD (Fig 1)
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TASK 2: Prepare the assembly during the drilling and also the part list 

Draw the following views

i Full sectional front elevation as given in (Fig 1).

ii Full plan.

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.9.144
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TASK 3: Draw the followings views of the Drill Jig (Fig 1)

-  Draw the working drawing details of drill jig with re-
quired views.

-  Draw the full sectional assemble elevation of the drill 
jig.

- Draw the plan.

FULL SECTIONAL ELEVATION OF DRILLING JIG

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.9.144
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Capital Goods & Manufacturing  Exercise 2.9.145 
Draughtsman Mechanical - Production drawing  

Create production drawing of a screw jack 
Objectives: At the end of this exercise you shall be able to
• draw use detailed drawing of a screw pack.

Requirements

Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Draw use detailed drawing of a screw pack (Figs 1&2)
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RIGHT HALF SECTIONAL ELEVATION

CG & M : Draughtsman Mechanical (NSQF - Revised 2022) - Exercise 2.9.145
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Capital Goods & Manufacturing  Exercise 2.9.146 
Draughtsman Mechanical - Production drawing 

Create the check list for self assessment revision table 
Objectives: At the end of this exercise you shall be able to
• prepare/create a check list for production drawing of a component
• prepare a revision mark by noting revision table.

Requirements
Tools/Equipment/Machines

• Auto CAD 2018 or Higher version.

PROCEDURE

TASK 1: Prepare/create a check list for production drawing of a component & revision marks
Check list for the production drawing & Revision 
marks 

•   To Ensure that all the part drawings are prepared with 
reference to assembly drawing.

•   To Ensure that the proper projection method used in 
the drawing 

•   To Ensure that all the parts are dimensional as per 
BIS.

•   To Ensure that Geometrical tolerance symbols and 
machining symbols are provided as per BIS.

•   To Ensure that proper fit. Provided for the mating parts.

•   To Ensure that the part no, material, qty & notes for 
heat treatment other important notes are provided.

•   To Ensure that the welded parts have welding symbols.

•   To Ensure that the bought - out items like - fasteners 
etc.., should be mentioned in the bill of material.

•   To Ensure that the scale used and the drawing number 
are mentioned in the title block.

•   To Ensure that if any changes are made in the drawing 
it should be mentioned in the revision table.

TASK 2: Prepare a revision mark by noting revision table (Figs 1&2)
Revision mark by noting revision table
© N

IM
I 

NOT T
O B

E R
EPUBLI

SHED


	Content
	Module 1
	Module 2
	Module 3
	Module 4
	Module 5
	Module 6
	Module 7
	Module 8
	Module 9



